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How to...

 Jump to a Help topic 
using the mouse 
Point to the Help topic and 
click the mouse button.

Jump to a Help topic using
the keyboard
Press Tab until you highlight 
the Help topic, and then 
press Enter.

 Close this or any other 
front window
Click the Control-menu box, 
and then click Close.

[demo button] 

Using Cinemania Help
Finding What You Want
Finding a Movie Listing
Finding a Biography
Finding a Topical Article or Definition
Finding Specific Words
Exploring a Basic Movie Listing
Exploring an Expanded Movie Listing
Exploring a Biography
Exploring a Topic
Using the MultiMedia Gallery
Using the Award List
Using the ListMaker
Using the Overview Screen
Copying Text
Changing your Printer or Print Setup
Annotating an Article
Using Keyboard Equivalents
Error Messages
Help Terms
Questions and Answers
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 Text box
Provides a space to type the title of the subject you want:

In the text box, type the title of the subject, moving 
through the list until the title you want is highlighted. (For example,
if you type este, the list moves to Estevez, Emilio.)

How to Use the Contents Dialog Box

 How to Use the Contents Dialog Box
1.In the text box, type the title of the subject, moving 

through the list until the title is highlighted. (For example, 
if you type este, the list moves to Estevez, Emilio.)
-or-
Use the scroll bar to move through the list, and then click
the title of the subject.

2.Click Go To Subject.
 You can also double-click the title to jump to the subject.

Example
1.Type dances with in the text box.

The list moves to Dances with Wolves.
2.Click Go To Subject.

You jump to the Dances with Wolves movie listing.

 Current Contents list
Lists all the subjects (movie listings, biographies, and 
topics) to which you can jump:
1.Use the scroll bar at the right to move through the list until 

you find the subject.
2.Click the subject title.
3.Click Go To Subject.

How to Use the Contents Dialog Box

 All Contents button
Displays the complete Contents list, including movie 
listings, biographies, and topics:

Click All Contents.

 Movies button
Displays the list of movies:

Click Movies.



 Biographies button
Displays the list of biographies:

Click Biographies.

 Topics button
Displays the list of topics:

Click Topics.

 Cancel button
Closes Contents and returns you to the last screen you 
were viewing:

Click Cancel.

 Help button
Displays the Help screen you are currently viewing:

Click Help.    
To go to Help Contents to choose a different Help topic:

Click Contents on the Help button bar.

 Go To Subject button
Jumps to the selected subject:

Click Go To Subject.
How to Use the Contents Dialog Box

 Instructions display area
Here you see instructions for using the 
Contents dialog box.
When you use the buttons on the Controller to display the 
list of movies, list of biographies, or list of topics, you will 
see filters for narrowing these lists in this area.



There are no filters for All Contents, since it includes all 
subjects.

 See Also
Finding a Movie
Finding a Biography
Finding a Topic

 Example
Not sure what you're looking for? Use Contents to browse 
through the subjects in Cinemania '94.
1.At the bottom of the Controller, click Contents.

You see a list of movie listings, biographies, and topics.
2.Use the scroll bar to move through the list until an intriguing 

title is highlighted, say 2001: A Space Odyssey. Click Go To 
Subject, and jump to the movie listing. Now, how about film 
biographies.

3.Click Contents, and then click Biographies.
4. Is Debra Winger a favorite? In the text box above the list, 

type winger to move through the list until her name is 
highlighted. 

5.Click Go To Subject. Her biography appears.
6.When you've through reading, click Contents.
7.The articles on film subjects are worth browsing through. 

Click Topics. Use the scroll bar to move through the list.
8.Animation sounds interesting. Click the title, click Go To 

Subject and the topic appears.
9.When you're through, click Contents or, if you see the title of

a movie, biography, or topic highlighted in a contrasting 
color, click the title (it's hot), and jump directly to it.

Happy browsing!
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 Text box
Provides a space to type the title of the movie you want:

In the text box, type the title of the movie, moving through 
the list until the title you want is highlighted. (For example, if you 
type gho, the list moves to Ghost, The.)

How to Find a Movie Listing 

 How to Find a Movie Listing
1.In the text box above the list, type the title of the movie, 

moving through the list until the title is highlighted. (For 
example, if you type gho, the list moves to Ghost, The.)
-or-
Use the scroll bar to move through the list until you find the 
movie title, and then click the movie title.

2.Click Go To Subject.

 You can also double-click the movie title to jump to the movie
listing.

Example
1.In the text box, type dances with.

The list moves to Dances with Wolves.
2.Click Go To Subject.

You jump to the Dances with Wolves movie listing.
 The list of movies appears as you last created it. So, if you 

have used the filters to narrow it down, only those types of movies
you have selected are in the list.

 Current Contents list
Lists all of the movies to which you can jump:

Use the scroll bar at the right to move through the list until 
you find the movie.

How to Find a Movie Listing

 Genres filter
Narrows down the list of movies to one or more genres:
1.Click the arrow to the right of the Genres filter to see the 

list.
2. In the list, click as many genres as you wish.
3.Click the arrow to the right of the the filter to close it.    

Click All Movies to include movies of all genres.



 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 MPAA Ratings filter
Narrows down the list of movies by the Motion Picture 
Association of America (MPAA) ratings:
1.Click the arrow to the right of the filter to see the MPAA 

ratings.
2. In the list, click as many MPAA ratings as you wish.

Click All Movies to include movies with all MPAA ratings.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Directed By filter
Narrows down the list of movies by director:
1.Click the arrow to the right of the Directed By filter.
2. In the filter text box, type the name of the director, moving 

through the list until the name is highlighted. (For example,
type fell and the list moves to Fellini, Federico.)
-or-
Use the scroll bar to move through the list.

3.Click the director's name.
To clear this filter and return to All Movies, click the arrow to 
the right of the filter, press the Spacebar, and then click the 
arrow again.

 When you are finished selecting filters and have the 
Contents list you want, you can click a subject in the list, and 
then click Go To Subject.

 Starring filter
Narrows down the list of movies by performer:
1.Click the arrow to the right of the Starring filter text box.
2. In the filter text box, type the name of the performer, moving

through the list until the name is highlighted. The list moves 
as you type. (For example, type stre and the list moves to 
Streep, Meryl.)
-or-
Use the scroll bar to move through the list.

3.Click the name of the performer.
To clear this filter and return to All Movies, click the arrow to 
the right of the filter, press the Spacebar, and then click the 
arrow again.



 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Also Starring filter
Narrows down the list of movies by performer:
1.Click the arrow to the right of the Also Starring filter text 

box.
2. In the filter text box, type the name of the performer, moving

through the list until the name is highlighted. The list moves 
as you type. (For example, type stre and the list moves to 
Streep, Meryl.)
-or-
Use the scroll bar to move through the list.

3.Click the name of the performer.
To clear this filter and return to All Movies, click the arrow to 
the right of the filter, press the Spacebar, and then click the 
arrow again.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.



 Awards filter
Narrows down the list of movies by Academy Awards or 
nominations received:
1.Click the arrow to the right of the Awards filter to see the 

list.
2.Click Nominees (and Winners) to include not only movies 

that have won Academy Awards but those that have been 
nominated as well.
-or-
Click Winners Only to include those movies that have 
actually won Academy Awards.

Click All Movies to include movies regardless of nominations 
or awards.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Dates filter
Narrows down the list of movies by year (or years) of 
release:
1.In the Dates filter text box on the left, select the year that is

currently in the box, and then type the earliest year you 
want in your range.

2.Repeat the process in the Dates filter text box on the right, 
typing the latest year you want in your range.    

 You can also click the up or down arrows to scroll through 
each list of years and then click the years you want. 

Examples

To include only movies issued between the years 1970 
and 1990, set 1970 in the filter on the left and 1990 in the filter on
the right.

To include only movies issued in 1939, set 1939 in both 
Year filters.

When the filters are set at 1914 and 1993 (their default 
settings), movies are included in the list regardless of year of 
release.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Video Availability filter
Narrows down the list of movies by availability on 
videocassette and videodisc:
1.Click the arrow to the right of the Video Availability filter to 



display the list.
2.Select as follows:

Click Videocassette to include only those movies 
available on videocassette.

Click Videodisc to include only those movies available on 
videodisc.

Click Videocassette and/or Disc to include movies 
available on videocassette and/or videodisc. 

Click All Movies (Maltin) to include movies regardless of 
availability on videocassette and videodisc.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Available Reviews filter
Narrows down the list of movies by type of review:
1.Click the arrow to the right of the Available Review filter to 

see the list.
2. In the list, click the types of review you want to include. 
3.Click the arrow to the right of the filter to close it.

Every movie listing includes a Maltin review. For selected 
movies, Ebert, Kael, and Baseline reviews are also 
available.

Click All Movies (Maltin) to include movies with all types of 
reviews.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Star Rating filter
Narrows down the list of movies by star ratings:
1.In the left Star Rating filter, click the up or down arrow until

you have the lowest acceptable star rating.
2. In the right Star Rating filter, click the up or down arrow 

until you have the highest star rating that you want.

Examples

If you want only those movies in your list with better than
average ratings, set three stars in the space on the left and four 
stars in the filter on the right.

If you want only the very highest rated movies in your 
list, set four stars in both filters.



If you want movies in the list regardless of star rating, 
one star should appear in the filter on the left and four stars in 
the filter on the right. 

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Reset All button
Resets the filters to their defaults:

Click Reset All.
The filters are cleared so that no subjects are excluded from
the list.

 Include TV Movies check box
Lets you include or exclude movies made for television:

Click the check box next to Include TV Movies.

 When you have the Contents list you want, you can click a 
subject in the list, and then click Go To Subject.

 Go To Subject button
Jumps to the selected movie listing:

Click Go To Subject.
How to Find a Movie Listing

 Example
The Movies button narrows the Contents list to movies only. 
You can then use the filters to narrow down the list even 
further.
For example, you like Clint Eastwood's comedies, but only 
the relatively recent ones.
1.Click the arrow to the right of the Genres filter.
2. In the list, click Comedy. Now only comedies are listed in 

Contents.
3.Click the arrow to the right of the Starring filter, type 

eastwood in the filter text box to move through the list, 
and then click Eastwood, Clint. 

4. In the Dates filter on the left, select the year currently 
appearing in the text box, and type 1980. Leave the Dates 



filter on the right set at 1993.

Now you have a list of Clint Eastwood comedies released 
between 1980 and 1993.

 See Also
Finding a Biography
Finding a Topic
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 Gender filter
Narrows down the list of biographies to men or to 
women:
1.Click the arrow to the right of the Gender filter.
2. In the list, click Male or Female.
3.Click the arrow to the right of the filter to close it.

Click All Biographies to display a list of biographies 
regardless of gender.

 When you are finished selecting filters and have the 
Contents list you want, you can click a subject in the list, and 
then click Go To Subject.

 Country filter
Narrows down the list of biographies by countries:
1.Click the arrow to the right of the Country filter to see the 

list.
2. In the list, click the countries you want to include.
3.Click the arrow to the right of the filter to close it.

The "country" of a person is sometimes not their country of 
birth, but the country where they have accomplished the 
bulk of their work. For example, Anthony Quinn was born in 
Mexico, but most of his films have been made in the USA.
Click All Biographies to display a list of biographies 
regardless of country.

 When you are finished selecting filters and have the 
Contents list you want, you can click a subject in the list, and 
then click Go To Subject.

 Occupation filter
Narrows down the list of biographies by occupations:
1.Click the arrow to the right of the Occupation filter to see 

the list.
2. In the list, click the occupations you want.
3.Click the arrow to the right of the filter to close it.

Click All Biographies to display a list of biographies 
regardless of occupation.

 When you are finished selecting filters and have the 
Contents list you want, you can click a subject in the list, and 
then click Go To Subject.



 Text box
Provides a space to enter the name of the person 
whose biography you want to jump to:

In the text box, type the name of the person, moving 
through the list until the name of the person is highlighted. (For 
example, type schw and the list moves to Schwarzenegger, 
Arnold. Or, type ford, h and the list moves to Ford, Harrison.)

How to Find a Biography

 How to Find a Biography
1.In the text box at the top of the list, type the name of the 

person, moving through the list until the name is 
highlighted. (For example, type schw and the list moves 
to Schwarzenegger, Arnold.)

2.Click Go To Subject.

 You can also double-click the person's name to jump to the
biography.

 Alternatively, you can use the scroll bar to move through 
the list, and then click the name. However, the list is long and 
typing the name is more efficient.

Example
1.In the text box, type goldb.

The list moves to Goldberg, Whoopi.
2.Click Go To Subject.

You jump to the Whoopi Goldberg biography.

 The list appears as you last created it. So, if you have 
previously used the filters to narrow it down, only those types of 
biographies you have selected will be included. To reset the 
filters to their defaults, click Reset All.

 Current Contents list
Lists the biographies to which you can currently jump.
1.Use the scroll bar to move through the list until you find the

name.
2.Click the name.
3.Click Go To Subject.

 You can also double-click the person's name to jump to the 
biography.

 Typing the name in the text box, moving through the list 
until the name is highlighted, is an easier way to find a 
biography.



How to Find a Biography

 Go to Subject button
Jumps to the selected biography:

Click Go To Subject.
How to Find a Biography

 Example
It's fun to browse through the biographies. (Note that when 
the list contains only biographies, the Biographies button is 
lit.) You can use the filters to the right of the list to narrow it 
down to particular types of biographies. For example, you 
might be interested in male Swedish directors. 
1.Click the arrow to the right of the Gender filter, click Male, 

and then click the arrow again to close the filter. Note that 
the Contents list (left) now includes only the biographies of
men.

2.Click the arrow to the right of the Country filter.
3. In the list, click Sweden, and then click the arrow.
4.Click the arrow to the right of the Occupation filter.
5. In the list, click Director, and then click the arrow.
Now, the Contents lists biographies of male Swedish 
directors.

 See Also
Finding a Movie
Finding a Topic
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Text box
Provides a space to enter the title of the topic or the 
definition you want:

In the text box, type the title of the article or the term you 
want, moving through the list until the title is highlighted. (For 
example, type neo and the list moves to neorealism.)

How to Find a Topic

 How to Find a Topic
1.In the text box at the top of the list, type the title of the 

article or the term you want defined, moving through the 
list until the title is highlighted. (For example, type neo and
the list moves to neorealism.)

2.Click Go To Subject.

 Alternatively, you can use the scroll bar to move through 
the list, and then click the title.

 You can also double-click the title to jump to the topic.
Example
1.In the text box, type tar, moving through the list until 

Tarzan Series is highlighted.
2.Click Go To Subject.

You jump to the article about the Tarzan series.

 The list appears as you last created it. So, if you have 
previously used the the filters to narrow it down, only those types
of articles you have selected will be included. To reset the filters 
to their defaults, click Reset All.

 Current Contents list
Lists the topics and definitions to which you can 
currently jump:
1.Use the scroll bar to the right of the list to move through it 

until you find the title.
2.Click the topic title.
3.Click Go To Subject.

 You can also double-click the title to jump to the topic.
How to Find a Topic

 All Topics button
Displays all of the topics and definitions in the Contents
list:



Click All Topics.

 Go to Subject button
Jumps to the selected topical article or definition:

Click Go To Subject.
How to Find a Topic

  Subject Groups
Narrows down the list of topical articles and definitions 
by subject group:

. Click as many subject groups as you like.

 See Also
Finding a Movie
Finding a Biography



 Example
The Topics button narrows down the Contents list to topical 
articles and definitions of film terms.    (Note that when the list 
contains only topics, the Topics button is lit.) Some topics 
offer both an article and a definition, some one or the other. 
You can use the filter to the right of the list to narrow it down 
to a particular type of article or definition.
For instance, you might want to read articles about the 
different types of movie genres.

Click the check box next to Movie Genres.
The list now contains only articles on and definitions of the 
different kinds of movie genres.
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 Control-menu box
Displays a menu of commands, which you can use to
close, resize, and move the active window, and to 
switch to other open applications:

Click the Control-menu box.
The Control menu appears, with the following 
commands:
Restore Move
Size Minimize
Maximize Close
Switch To

 See your Microsoft Windows documentation for 
complete information on using the commands on the Control 
menu.

 Restore command
Click to restore the window to its previous size.

 Close command
Click to close the active window.

 Size command
Click to change the cursor into the sizing tool. Then point 
to a border or a corner of the window and drag to the 
shape and size you want.

 Minimize command
Click to shrink the active window to an icon on the 
desktop. To restore the window, click the Control-
menu box, and then click Restore.

 You can also double-click the icon to restore the 
window.

 Maximize command
Click to enlarge the active window to fill the screen. 

 Switch To command
Click to open the Task List box, where you can switch



to or close any open applications, and rearrange 
icons and windows on your desktop.

 Move command
Click to change the cursor into the moving tool. Then 
point to the title bar and drag the window to its new 
location.

 Title bar
Identifies the window and lets you move it to a new 
location:
Point to the title bar, hold down the mouse button (normally 
the left mouse button), drag the window to its new position, 
and then release the mouse button.

 Minimize button
Reduces the Cinemania '94 window to an icon on the 
desktop:

Click the Minimize button.
The window shrinks to an icon on the desktop. Cinemania 

'94 remains open.

To restore the window:

Click the icon, and then click Restore or Maximize.
The window reappears.

 Maximize button
Maximizes the Cinemania window so that it fills the 
screen:

Click the Maximize button.
The window fills the screen. The Maximize button is 

replaced by the Restore, which you can use to restore the window 
to its previous size.

 



 Overview button
Jumps to the Overview screen, where you can find 
product information:

Click the Overview button.
The Overview screen appears, where you can see a 
description of the features in Cinemania '94, a list of sources 
for the information in the product, and information on 
ordering videotapes and/or videodiscs.

 Options button
Displays the Options menu of commands, which you can 
use to add an annotation to a subject, change print 
settings, and change the color of hot text:

Click the Options button.
The Options menu appears, with the following commands:

Choose To
About 
Cinemania

Find the address to which you can write in 
case you have suggestions for improvements
or additions to Cinemania '94.

Annotate Display the Annotate dialog box, where you 
can add your own annotation to a Cinemania 
'94 subject.

Print Setup Display the Print Setup dialog box, where you
can change your printer and printer settings.

Hot Text Color Display the Hot Text Color dialog box, where 
you can change the color of the hot text in 
the product.

Exit CinemaniaExit Cinemania '94.

 Hot Text Color
Lets you change the color of hot text.
Click below to pop up information.



 Jump Color
Sets the color of the jump text:

Use the scroll bar if necessary to move to the color 
you want, and then click the color.

To set the color option and close the Set Colors dialog
box:

Click OK.

 The default color for jump text is blue. 

 Popup Color
Sets the color of the popup text:
1.Use the scroll bar if necessary to move to the color you 

want, and then click the color.
2.Click OK.

 The default color for popup text is blue. 

 OK button
Sets the color you've selected and closes the Set Hot 
Text Color dialog box:

Click OK.

 Cancel button
Cancels any changes in the options and closes the Set 
Color dialog box:

Click Cancel.

Title bar
Identifies the window and lets you move it to a new 
location:
Point to the title bar, hold down the mouse button (normally 
the left mouse button), drag the window to its new position, 
and then release the mouse button.



 Back button
Jumps back to the screen you were previously viewing:

Click the Back button.
You can continue clicking Back to back up through the 
screens you have visited in the current Cinemania '94 
session.

 History button
Displays the History list of recently visited screens to 
which you can return:
1.Click the History button.

The History dialog box appears, listing the screens you've 
visited in the current Cinemania '94 session (up to a total 
of 40).

2.Use the scroll bar to move through the list, if necessary, 
and then click the screen you want to jump to.
The History dialog box remains open so that you can 
return to as many screens as you wish.

To close the History dialog box:

Click Cancel.

 Find Word button
Displays the Find Word dialog box, which you can use 
to find occurrences of a specific word or phrase:

Click the Find Word button:
The Find Word dialog box appears, where you can search 
Cinemania's movie listings, biographies, topics and 
definitions, and Award List for occurrences of a word or a 
phrase.

 To locate specific movies, biographies, or topics, it's easier 
to use the Contents button on the Controller. Use Find Word in 
special circumstances. For example, you might search the movie
listings for specific words such as:

chopin to find movies about this famous composer.

venice to find movies set in this city.

werewol* to find movies about werewolves (werewolf, 
werewolves).



christie AND marple to find movies made from Agatha 
Christies' Miss Marple novels.

For help on Find Word, click the Help button in the Find 
Word dialog box.
To jump to that Help topic right now, click below.
Finding Specific Words

 Award List button
Jumps to the Award List, where you can find 
information about Academy Awards and nominations:

Click the Award List button:

For help while you are using Award List, click  on the 
Controller.
To jump to that Help topic right now, click below.
Using the Award List

 Award List button
Jumps to the Award List, where you can find 
information about Academy Awards and nominations:

Click the Award List button:

 ListMaker button
Jumps to the ListMaker, where you can create, modify, or
print your own lists of movies:

Click the ListMaker button.

For help while you are using the ListMaker, click  on the 
Controller.
To jump to that Help topic right now, click below.
Using the ListMaker

 ListMaker button
Jumps to the ListMaker, where you can create, modify, or
print your own lists of movies:

Click the ListMaker button.





 Gallery button
Jumps to the MultiMedia Gallery, where you can browse 
through all the pictures, dialogue excerpts, music, and 
film clips in Cinemania '94:

Click the Gallery button.
The MultiMedia Gallery appears.

For help while using the MultiMedia Gallery, click  on the
Controller.

To jump to that Help topic right now, click below.
Using the MultiMedia Gallery

 Gallery button
Jumps to the MultiMedia Gallery, where you can browse 
through all the pictures, dialogue excerpts, music, and 
film clips in Cinemania '94:

Click the Gallery button.
The MultiMedia Gallery appears.



 Videocassette/videodisc icon
Shows you whether the movie is available on videocassette, 
on videodisc, or on both. 

Click the icon.
An informational popup appears.

Videocassette

Videodisc

Videocassette and/or videodisc

To close the popup:

Click outside the popup in an area that's not hot.

 Videocassette icon
Shows you whether the movie is available on videocassette, 
on videodisc, or on both. 

Click the icon.
An informational popup appears.

To close the popup:

Click outside the popup in an area that's not hot.
Videocassette

Videodisc

Videocassette and videodisc

 MPAA rating
Shows you the Motion Picture Association of America 
(MPAA) rating of the movie:

Click the icon.
An informational popup explaining the MPAA ratings 
appears.

To see a list of all the MPAA letter codes and their 
explanations:

Click More Info on the MPAA popup.
Another popup appears with the information.

To close the popup:



Click outside the popup in an area that's not hot.

 Length of movie
Shows you the length of the movie in minutes:

Click the icon.
A popup appears explaining the icon.

To close the popup:

Click outside the popup in an area that is not hot.

 Film strip
Shows you whether the movie is in color or in black and
white (or both):

Click the icon.
A popup appears explaining the icon.

To close the popup:

Click outside the popup in an area that is not hot.

 Award icon
Shows you the movie's nominations and awards from 
the Academy of Motion Picture Arts and Sciences:

Click the icon.
A popup appears listing the film's nominations and/or 
awards.

 In the popup, you can click any of the names or titles that 
appear in a contrasting color, and jump to that subject.

To close the popup:

Click outside the popup in an area that is not hot.

 

 button
Displays this Help screen:



Click the {ewc MvBmp2, ViewerBmp2, !helpq.dib} 
button.    

A {ewc MvBmp2, ViewerBmp2, !helpq.dib} button appears 
on the Controller on every screen in Cinemania '94. 
You will find a Help button in the upper-right corner of the 
Contents and the Find Word dialog boxes.

 Maltin button
Displays Leonard Maltin's review of this movie:

Click Maltin.

 << Previous button
Jumps to the previous subject in the Contents list:

Click the << Previous button.

 The subjects in the list reflect the selections you've made in 
the Contents dialog box using the Movie Listings, Biographies, 
Topics, and All Contents buttons and any of the filters.

 Contents button
Displays Contents, where you can locate a movie, 
biography, or topic to jump to:

Click the Contents button.
To jump to the Contents Help screen, click below.

Finding What you Want

 List button
Displays your current list of subjects:

Click the List button.
The Browse List of subjects--movies, biographies, and 
topics--appears. 

If the Browse List obscures your view, use the title 
bar to drag it to a new position. 
The Browse List stays open until you close it. To close the 
Browse List, click Cancel. 



 The subjects in the list reflect the selections you've made in 
the Contents dialog box, using the Movie Listings, Biographies, 
Topics, and All Contents buttons and any of the filters.

To change the list, click Contents.

 >> Next button
Jumps to the next subject in the Contents list:

Click the >> Next button.

 The subjects in the list reflect the selections you've made in 
the Contents dialog box, using the Movie Listings, Biographies, 
Topics, and All Contents buttons and any of the filters.

 Movie title
Tells you the title of the current movie listing, its year of 
release, its country of origin, and its genre (when available).

 Information source or type
Tells you the source or type of information currently displayed. 
For instance, if a movie review is displayed, it identifies the 
source of the review. 
When a movie review is displayed, you may also see a star 
rating or TV movie rating.
Click on the star rating to pop up an explanation.

 Copy button
Copies the text currently displayed (review, outline, cast 
list, or credits list) onto the Windows Clipboard:
1.Click Copy.

The Copy dialog box appears.
2. If you don't want to copy all of the text, select that portion 

you do want to copy.
3.Click Copy.

The text is copied onto the Windows Clipboard. 

 Copyright information is automatically appended to the 
copied text.

How to Paste Text into Another Application



 Print button
Sends the text currently displayed (review, outline, cast 
list, or credits list) to your printer:

Click Print.

 If you would like to format the text before printing it, use 
Copy instead and paste the text into another Windows 
application.

How to Paste Text into Another Application

 How to Paste Text into Another Application
To copy the text currently displayed onto the Windows 
Clipboard:
1.Click Copy.

If you don't want to copy all of the text, select that portion 
you do want to copy.

2.Click Copy. The text is copied onto the Windows Clipboard.
To paste the contents of the Windows Clipboard into 
another Windows application:
1.Click the Minimize button.
2. If necessary, open the other application (such as Microsoft 

Word for Windows).
3.Open the target file.
4.Click an insertion point.
5.From the Edit menu, choose Paste.
6.Format the text as you want it to appear in print.
To switch back to Cinemania '94:

Click the Control-menu box in the upper-left corner of the 
window, choose Switch To, click Microsoft Cinemania '94, and 
then click Switch To.

 Copyright information is automatically appended to the 
copied text. 

 Review display area
The movie review appears in this area.
Use the scroll bar to move through the information, if 
necessary.    Any text that appears in a contrasting color 
(normally blue) is hot, which means you can click it to jump to 
the relevant article. Hot text includes movie titles, people's 
names, topics, and movie term definitions.



 See Also
Exploring a Movie Listing (Expanded)
Exploring a Biography
Exploring a Topic



 Example
You've found your movie listing, Somebody Up There Likes 
Me. Now you're ready to explore.
In the top of the Controller, the top-left icon tells you the 
movie's Motion Picture Association of American (MPAA) rating.
For an explanation of the ratings, click the icon. The top-right 
icon tells you that the movie is in black and white. The center 
icon gives the movie's running time in minutes. The bottom-left 
icon tells you the movie's availability in video. Click the icon for 
an explanation. Click the bottom-right icon for information on 
the movie's awards and nominations. At the left, you see 
Leonard Maltin's review. The colored text (Robert Wise, Paul 
Newman, etc.) is hot. You can click it to jump to that subject.
1.Click Paul Newman and his biography appears.
2.Click Awards to see a list of the actor's Academy Award 

nominations and wins.
3.To find out about his other early films, click Filmography. 
4.The Silver Chalice? To check it out, just click the title.
5.Interesting. Now, who else was in Somebody Up There Likes

Me? Click History. You see a list of the screens you've just 
visited.

6.Click Somebody Up There Likes Me, and then click Go To. 
(Or, double-click the title.)
Now, to return to the previous subject, The Silver Chalice, 
click the title in the History list (if the History list isn't open, 
click Back on the button bar).
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 Ebert button
Displays Roger Ebert's review of the movie:

Click Ebert.
This button appears on the Controller only when an Ebert 
review is available.

 Baseline button
Displays the Baseline Motion Picture Guide review of 
the movie:

Click Baseline.
This button appears on the Controller only when a review 
from Baseline's The Motion Picture Guide is available. 

 Kael button
Displays Pauline Kael's review of the movie:

Click Kael.
This button appears on the Controller only when a Kael 
review is available.

 Cast List button
Displays the movie's cast of characters:

Click Cast List.
This information comes from Baseline's Motion Picture Guide 
and is available only for those movie listings that include a 
Baseline review.

 Credits button
Displays a list of the movie's major production credits:

Click Credits.
This information comes from Baseline's Motion Picture 
Guide and is available only for those movie listings that 
include a Baseline review.



 Dialogue button
Displays a caption for a dialogue excerpt and icons for 
playing it and displaying its text:
1.Click Dialogue.

The caption and the icon appear.
2.Click .

The dialogue excerpt plays.

To see the text of the dialogue:

Click 
.

The Dialogue button appears when a dialogue excerpt is 
available without a matching movie still.

 Many dialogue excerpts appear with a movie still.

 Still+Dialogue button
Displays a movie still, a caption for a dialogue excerpt 
and icons for playing it and displaying its text:
1.Click Still+Dialogue.

The caption and the icons appear.

2.Click .
The dialogue excerpt plays.

To see the text for the dialogue clip:

Click .
The Still+Dialogue button appears when a movie still 
accompanied by a dialogue excerpt is available. When the 
movie still is not accompanied by a dialogue excerpt, the 
Movie Still button appears here.
When a dialogue clip is available, the Dialogue button also 
appears on the Controller.

 Film Clip button
Displays the opening frame of the film clip, control 
buttons for playing the scene, an icon for displaying the 
text of the dialogue, and a caption:

Click Film Clip.
The film clip, the caption, and the icon appear.

To control the film clip:

 Click to play the film clip.
 Click to pause.
 Click to rewind the film clip.



To display the text for the dialogue in the scene:

Click .

 It is best to play only one media element at a time. If you 
want to play a Demo or some other gallery item, click 

 first.
How to View a Full-Screen Film Clip

 How to View a Full-Screen Film Clip
1.Click the Control-menu box in the upper-left corner of the 

window, choose Switch To, click Program Manager, and 
then click Switch To.

2. In the Program Manager Main group window, click the 
Control Panel icon, and then choose Open from the File 
menu.

3.Click Settings, and then click Drivers (or double-click the 
Drivers icon).

4. In the Drivers dialog box, scroll through the list, if 
necessary, and click [MCI] Microsoft Video for Windows.

5.Click Setup, and then in the Video Playback Options box, 
click the checkbox for Full Screen.

6.Click Set Default.
7.Click Close.
8. In the Program Manager Main group window, choose 

Switch To, click Microsoft Cinemania '94, and then click 
Switch To.

DO NOT change any other settings while you are in the Video
Playback Options box!

 The film clip fills the screen and the film clip controller 
disappears. To stop the film clip, press Esc.

 Movie Stills button
Displays a still from the movie: 

Click Movie Stills.
The picture appears in the display area to the right.

 This button appears when a movie still from the movie is 
available. When a movie still is accompanied by a dialogue 
excerpt, the Still+Dialogue button appears here.

To play an accompanying dialogue excerpt:

Click .
To display the text of the dialogue:



Click 

 Music button
Displays an icon for playing a musical excerpt from the 
film and its caption:
1.Click Music.

A caption for the music excerpt and an audio icon  for
playing it appear in the display area to the right.

2. Click .
The music plays.

To pause:

1.Click  again.
The music stops.

2. Click .
The music begins playing where it left off.

 If you click any other buttons while the music is playing, the
music stops and you must click the icon again to replay it.

 Movie title area
Tells you the title of the movie currently displayed, along with
its year of issue, country of origin, and genre(s).

 Outline button
Displays the outline of the Baseline review, which you can
use to jump to a specific section of the review:

Click Outline.
The outline appears.

To jump to a section of the review:

Use the scroll bar, if necessary, to move to the section you
want, and then click the section title.

To display the review again:

Click Review.

 This button is present only when a lengthy Baseline review is
displayed.



 Review button
Displays the Baseline review:

Click Review.
The review appears.

To display the outline of the review:

Click Outline.

 This button is present only when a lengthy Baseline review is
displayed.

 Display area
Here you see the movie information (review, outline, cast of 
characters, production credits) or gallery item, depending on 
what you've selected. Use the scroll bar at the right, if 
necessary, to move through the information.    Any text that 
appears in a contrasting color (normally blue) is hot, which 
means you can click it to jump to the relevant article. Hot text
includes movie titles, people's names, topic titles, and movie 
term definitions.

To play the various gallery items:

 Click to listen to a dialogue or music excerpt.

 Click to see the text of the dialogue excerpt.

 Click to play the film clip.

 Click to pause.

 Click to stop the film clip.
How to View a Full-Screen Film Clip

 Example
Let's say you've used Contents to find the movie listing you 
want--The Godfather, for example. Now you want to explore 
everything the movie listing has to offer.
Take a look at the Controller. The top-left icon tells you the 
movie's MPAA rating. For an explanation of the ratings, click 
the icon. The top-right icon    tells you that the movie is in 
color. The center icon shows the movie's running time in 
minutes. The bottom-left icon tells you the movie's availability 
in video. Click the icon for an explanation. Click the bottom-



right icon to see information about the movie's awards and 
nominations. Now:
1.Click Baseline to see the Baseline review. See the names 

and titles in a contrasting color?    This text is hot. You can 
click it to jump to that subject.

2.Explore the other reviews, using the Maltin, Ebert, and Kael
buttons.

3.Want to see the movie still again? Click Still+Dialogue.

4.Now, click  to hear a dialogue excerpt. 

5. To see the text of the dialogue, click .
6. For an excerpt of the familiar theme music, click the 

Music button, and then click .
7. Last, take a look at a famous scene. Click Film Clip, and 

then click . 

 See Also
Exploring a Biography
Exploring a Topic
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 Portrait
Here you see a portrait of the selected individual, when 
available.    

 Biography button
Displays the biography:

Click Biography.
The biography appears. 

 Filmography button
Displays the filmography:

Click Filmography.
The filmography appears.

You can jump to any of the movies in the list when the title 
appears in a contrasting color (normally blue).    Simply click 
the title. 

 Awards button
Displays a list of Academy Awards and nominations for 
the selected individual:

Click Awards.
The list appears.

You can jump to any of the movies in the list when the title 
appears in a contrasting color (normally blue).    Simply click 
the title. 

 Biography title
Here you see the name of the person whose biography is 
currently displayed, the year of birth, and, if appropriate, the 
year of death. (The birth and death dates are not always 
available.)

 Source of biography/filmography
Here you see the source of the displayed biography or 
filmography, either Baseline's Encyclopedia of Film or Katz's 



Film Encyclopedia.

 Print button
Sends the text of the biography or filmography to your 
printer:

Click Print.

 If you would like to format the text, use Copy instead and 
then paste the text into another Windows application.
How to Paste Text into Another Application

 Copy button
Copies the text of the biography or filmography onto 
Windows the Windows Clipboard:
1.Click Copy.

The Copy dialog box appears.
2. If you don't want to copy all of the text, select the portion 

you do want to copy.
3.Click Copy.

 Copyright information is automatically appended to the 
copied text. 
How to Paste Text into Another Application

 Information area
Here you see either the biography or the filmography of the 
person. Use the scroll bar at the right to move through the 
information, if necessary.    

Any text that appears in a contrasting color (normally blue) 
is hot, which means you can click it to jump to the relevant 
article. Hot text includes movie titles, people's names, topic 
titles, and movie term definitions.

 Example
Let's say you've used Contents to find Glenn Close's 
biography. Now, you're ready to explore.
1.On the Controller, click Filmography and get a list of the 

actress's movies. Most of the movie titles are in a 
contrasting color, which means they're hot. You can click 
the title and jump to the movie listing.

2.Right now, you may want to read more about the actress, 



so click Biography.
3.Now you can use the scroll bar to move through the text of 

the biography. 
4.Click Fatal Attraction, and take a look at that movie listing. 

Nice movie still.
5.On the Controller, click Maltin so that you can see what 

Leonard Maltin thinks of the movie. 
6.Then, you see Michael Douglas's name in a contrasting 

color. Click it to jump to his biography.
7.Ready to go back to Glenn Close's biography? Then click 

History on the button bar. 
8.From the list, click Glenn Close Biography, and then click 

Go To. (To close the History dialog box, click Cancel.)
9.Now, check out her awards by clicking the Awards button.

 See Also
Exploring a Movie Listing
Exploring a Topic
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 Controller window
The Controller display area on the Topics screen contains a 
graphic.

 Topical Article button
Displays the topical article:

Click Topical Article.

 This button is present when a topical article is available. 
Topics may include a topical article, a definition, or both.

 Definition button
Displays the definition:

Click Definition.

 This button is present when a definition is available. Topics 
may include a topical article, a definition, or both.

 Article button
Displays the article:

Click Article.
To display the outline of the review:

Click Outline.

 This button and the Outline button are present only when an
outline is available for the article. 

 Outline button
Displays the outline for the article:

Click Outline.
The outline appears.

To jump to a section of the article:

Click the section title.
The section of the article appears.



 This button and the Article button are present only when an 
outline is available for the article. 

 Print button
Sends the text currently displayed (article, outline, or 
definition) to your printer:

Click Print.

 If you would like to use a word-processing program to 
format the text, use Copy instead.

To copy the text onto the Windows Clipboard:

Click Copy.
How to Paste Text into Another Application

 Copy button
Copies the text currently displayed (article, outline, or 
definition) onto the Windows Clipboard:

Click Copy.
The Copy dialog box appears, displaying the current text.

If you don't want to copy all of the text, select that part you
do want to copy.

Click Copy.
The text is copied onto the Windows Clipboard.

How to Paste Text into Another Application

 Topic title
Here you see the title of the topic.

 Source of topic
The source of the current topical article is identified here as 
Baseline's Encyclopedia of Film, Monaco's Film Term 
Glossary, or Katz's Film Encyclopedia.

 Topic display area
Here you see the text of the article or its outline, or the 



definition. Use the scroll bar at the right to move through the 
information, if necessary.

To jump to a section from the outline:

Click the section title.    
The section of the article appears. 

Any text that appears in a contrasting color (normally blue) is
hot, which means you can click it to jump to the relevant 
article. Hot text includes movie titles, people's names, topic 
titles, and definitions of movie terms.

 In the text of a topical article, all other topical article titles 
and definitions are hot. In the rest of Cinemania '94, 
commonplace terms (such as director) are not hot because they 
appear so frequently.

 Example
You've used Contents to locate a topic you're interested in 
(film noir, for instance). Now, you want to explore the topic.
1.Read the definition of film noir and then take a look at the 

article.
Click Topical Article. 

2.Use the scroll bar to move through the text in the display 
area. Notice the terms, names, and movie titles in a 
contrasting color? That means they're hot; you can click 
the text and jump directly to the subject.

3.Click The Postman Always Rings Twice and take a look at
that movie listing.

4.Click Back to return to the article.
5.Try clicking one of the terms emphasized with a 

contrasting color, tones, for example. You pop up a 
definition of the term.

 See Also
Exploring a Movie Listing
Exploring a Biography
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 Text box
Provides a space to type the title of the gallery item you 
want to display:

In the text box, type the title of the gallery item, moving 
through the list until you are close to the title you want. (For 
example, type godf and the list moves to Godfather, The.) Click 
the title of the gallery item to highlight it, if necessary.

How to Explore a Gallery Item

 How to Explore a Gallery Item
1.In the text box, type the title of the gallery item, moving 

through the list until you are close to the title you want. (For 
example, type godf and the list moves to Godfather, The.)
-or-
Use the scroll bar to move through the titles.

2. If necessary, click the title to highlight it.
3.Click Show Media.

 You can also double-click the title of the gallery item to 
display it.

To hear a dialogue excerpt or play music, Click .

To pause in a dialogue or musical excerpt, click .
(If you click a button on the Controller or elsewhere, you 

stop the excerpt.)

To see the text of the dialogue excerpt, click . 

To control a film clip, click  to pause in it,  to stop

it, and  to play it.

 It is best to play only one media element at a time. If you 

want to play a Demo or some other gallery item, click  first.
How to View a Full-Screen Film Clip

 Gallery list
Lists the titles of the gallery items: 
1.Use the scroll bar to move through the list of gallery items.
2.Click the title of the gallery item.
3.Click Show Media.

You can use the buttons on the Controller to narrow the 
list.



 It is best to play only one media element at a time. If you 

want to play a Demo or some other gallery item, click  first.
How to Explore a Gallery Item

 Show Media button
Displays the selected gallery item in the display area:

Click Show Media.
How to Explore a Gallery Item

 Go to Subject button
Exits MultiMedia Gallery and jumps to the subject 
associated with the selected gallery item:

Click the Go to Subject button. 

 Movie Stills button
Displays a list of all the movie stills in Cinemania 1994:

Click Movie Stills.
All of the movie stills accompanied by dialogue excerpts are
also included in the list.

How to Explore a Gallery Item

 Portraits button
Displays a list of all the portraits in Cinemania 1994:

Click Portraits.
How to Explore a Gallery Item

 Dialogue button
Displays a list of all the dialogue excerpts in Cinemania 
1994:

Click Dialogue.
The list of dialogue excerpts appears, including those 



acompanied by movie stills.

How to Explore a Gallery Item

 Film Clips button
Displays a list of all the film clips in Cinemania 1994:

Click Film Clips.
The list of film clips appears.

 It is best to play only one media element at a time. If you 

want to play a Demo or some other gallery item, click  first.
How to Explore a Gallery Item

 All Media button
Displays a list of all the gallery items in Cinemania '94, 
including movie stills, portraits, dialogue excerpts, 
musical excerpts, and film clips:

Click All Media.
How to Explore a Gallery Item

 Music button
Displays a list of all the musical excerpts:

Click Music.
How to Explore a Gallery Item

 << Previous button
Displays the previous gallery item (in the current list) in
alphabetic order:

Click the << Previous button.

 The list is as you last created it, using the buttons on the 
Controller.

 >> Next button
Displays the next gallery item (in the current list) in 



alphabetic order:

Click the >> Next button.

 The list appears as you last created it, using the buttons on 
the Controller.

 Exit Gallery
Exits Multimedia Gallery and jumps back to the screen you
were viewing before you opened the gallery:

Click the Exit Gallery button.

 MultiMedia Gallery title
The title identifies the MultiMedia Gallery.

 Gallery item display area
Here you see the gallery item which you selected from the list
on the Controller. 

How to Explore a Gallery Item

 Example
The MultiMedia Gallery offers a potpourri of sights and 
sounds. 
1.Let's say you want to see Harrison Ford's picture. In the text 

box above the list, type ford, h to move through the list until 
Ford, Harrison is highlighted.

2.Click Show Media. His portrait appears.
3.Now, you can also find a movie still from one of his famous 

movies. In the text box, type star w to move through the list 
to the first Star Wars gallery item.

4.Click Show Media. The movie still appears.

5.To listen to the dialogue excerpt, click .

(If you want to see the text of the dialogue, click .
6. You can also hear some music from the film. Click the Star

Wars  item, click Show Media, and then click .

7. Now, click the Star Wars  item, and then click Show 
Media. The first frame of the film clip appears. 



Click .
8. When you've finished watching the film clip from Star 
Wars, you might want to browse through the other film clips. On 
the Controller, click Film Clips, and then select the one you want.

How to View a Full-Screen Film Clip
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 Category (or Year) text box
Provides a space to type the category (or year) for
which you want to find Academy Award information:

In the text box, type the category (or year), moving 
through the list until the item is highlighted. (For example, typing 
dir moves through the list of categories to Director, typing 1940 
moves through the list of years to 1940.)

How to Find Award Information

 How to Find Award Information
1.Click Category (or Year).
2. In the text box, type the category (or year), moving 

through the list until the category (or year) is highlighted. 
(For example, typing dir moves through the list of 
categories to Director, typing 1940 moves through the list 
of years to 1940.)

-or-
Use the scroll bar at the right to move through the 
categories (or years), and then click the category (or 
year).

3.Click Show Awards.
The award information for that category (or year) appears 
in the display area at the right.

 Double-clicking the category (or year) also displays the 
selection.

 List of Categories (or Years)
Lists the categories (Picture, Actor, Actress, etc.) or the 
years (1927to 1992) of the Academy Awards, for which you 
can display information:

Use the scroll bar to move through the categories 
(or years), and then click the category (or year).

 You can also double-click the category (or year) in the list to 
display the award information.

How to Find Award Information

 Show Awards button
Displays the selected award information in the display area 
to the right:



Click Show Awards.
How to Find Award Information

 Category button
Displays the Academy Awards by category (Picture, 
Actor, Actress, etc.):

Click Category.
The categories are listed in order of significance and in 
reverse chronological order, beginning with Best Picture of 
1992.

How to Find Award Information

 Year button
Displays the Academy Awards by year (1927 to 1992):

Click Year.
The awards are listed in reverse chronological order, 
beginning with the latest year for which we have award 
information, 1992.

How to Find Award Information

 Exit Awards button
Exits the Award List and jumps back to the screen you 
were viewing before you opened the Award List

Click Exit Awards.

 << Previous button
Displays the awards for the previous category (or year) in 
the list:

Click the << Previous button.

 >> Next button
Displays the awards for the next category (or year) in the 
list:



Click the >> Next button.

 Award List title
The title identifies the list of Academy Awards.

 Display information
Here you can see which Academy Award category or year is 
being displayed.

 Awards button
Displays the complete text of the Awards information in the
display area:

Click Awards.
Use the scroll bar to move through the information.

To see an outline of the Awards information:
1.Click Outline.

The outline appears.
2.Click the section title of the information you want to see.

 Outline button
Displays an outline of the awards information:
1.Click Outline.

The outline appears.
2.Click the section title of the information you want to see.

To see the complete text of the awards information:

Click Awards.
Use the scroll bar to move through the information.

 Copy button
Copies the text currently displayed onto the Windows 
Clipboard:

1.Click Copy.
The Copy dialog box appears, displaying the current text.

2. If you don't want to copy all of the text, select that part you do
want to copy.

3.Click Copy.



The text is copied onto the Windows Clipboard.

 Copyright information is automatically appended to the copied
text. 

How to Paste Text into Another Application

 Print button
Sends the text currently displayed to your printer:

Click Print.

 If you would like to format the text, use Copy instead and 
then paste the text into another Windows application (Microsoft 
Word for Windows, for example).

How to Paste Text into Another Application

 Academy Awards
Here you see either the Academy Awards arranged by 
category or the Academy Awards arranged by year . The list 
includes all nominations. The Oscar symbol indicates the 
winner. 

You have two ways to find the award information you 
want:

Click Outline, and then click the category (or year) you 
want.

-or-

Use the scroll bar at the right to move through the 
information.    

Any text that appears in a contrasting color (normally blue) is 
hot, which means you can click it to jump to the relevant 
article. Hot text includes movie titles and people's names.

 Example
The Award List presents all the nominees (and identifies the 
winners of course) in every category of the awards given by 
the Academy of Motion Picture Arts and Sciences. 
1.On the Cinemania '94 button bar, click Award List.

The list of categories appears.
2.On the Controller, click Year. 

The list of years (1927-1992) appears at the top of the 
Controller. The information appears in the display area to 
the left. Let's say you're interested in the awards for 1990.



3.Click 1990, and then click Show Awards.
The information appears. You notice Kevin Costner won 
the award for Best Director for Dances With Wolves, and 
you wonder which other actors have also won the Best 
Director award. 

4.On the Controller, click Category.
The list of categories appears at the top of the Controller. 

5. In the Controller list, click Director, and then click Show 
Awards. 
The information on the awards for Best Director appears in
the display area.

6.Use the scroll bar to move through the information. And 
there you find that Warren Beatty won for Reds in 1981 
and Robert Redford for Ordinary People in 1980.
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 Text box
Provides a space to type the title of the movie list you 
want to display:

In the text box, click an insertion point, and then type 
the title of your movie list.

How to Display a Movie List

 How to Display a Movie List
1.In the text box at the top of the Controller, click an insertion

point, and then type the title of your movie list.
-or-
Use the scroll bar to move through the list.

2.Click the title of the list.    
3.Click Show List.

Double-clicking the list title will also display it.
For example, you might create lists with titles such as Classics, 
W.C. Fields, Action, and Comedies. To see the list of action 
movies, you would click Action.

 Titles of movie lists
Displays the titles of your movie lists:
1.Click the title of the list. (If necessary, use the scroll bar to

move through the titles.)
2.Click Show List.

How to Display a Movie List

 Show List button
Displays the selected movie list in the display area to 
the right:

Click Show List.
How to Display a Movie List

 Add Movie button
Adds the movie name you've typed in the text box to the 
current movie list:
1.In the list of titles, click the title of the movie list.
2.Click Show List.



(Double-clicking the list title will also select it.)
3. In the Movie text box, click an insertion point, and then type

the name of the movie.    
4. If you like, fill in the Genre(s), Year, and Comments boxes.
5.Click Add Movie.    

 ListMaker alphabetizes the movies, so enter movie names 
such as The Birds as Birds, The. 

 Delete Movie button
Deletes the selected movie from the current movie list:
1.In the list at the top of the Controller, click the title of the 

movie list.
2.Click Show List.

(Double-clicking the list title will also select it.)
3. In the movie list at the right, click the name of the movie.
4.Click the Delete Movie button.    

 When you exit ListMaker, Cinemania '94 displays a dialog 
box asking you to confirm any changes or deletions.

 Delete List button
Deletes the current movie list:
1.In the list at the top of the Controller, click the title of the 

movie list.
2.Click Show List.

(Double-clicking the list title will also select it.)
3.Click Delete List.    

 When you exit ListMaker, Cinemania '94 displays a message
asking you to confirm any changes or deletions.

 Print List button
Sends the text of the current movie list to your printer:
1.In the list at the top of the Controller, click the title of the 

movie list.
2.Click Show List.

(Double-clicking the list title will also select it.)
3.Click Print List.

 New List button



Adds your new list:
1.Click the New List button.
2. In the box that appears, type a title for your new movie list.

Titles can contain up to 25 characters including spaces.
3.Click OK.
4.Add the movies to your list.

For example, you might create a list titled Comedies made 
up of Sister Act, My Cousin Vinnie, Back to the Future, and 
Housesitter.
Or for a list titled Sleepers, you might add City of Hope, Just 
One of the Guys, American Dreamer, and Criss Cross.

 The files containing your lists are saved in a directory on 
your hard disk. You CANNOT edit these lists, but you can back 
up the files, if you wish, or change the location of the directory. 
The Viewer.ini file in your Windows directory contains a section 
called [CNMNIA94].
In that section you'll find the following statement:
LISTPATH=[directoryname]

 << Previous button
Displays the previous movie list in alphabetical order:

Click the << Previous button. 

 >> Next button
Displays the next movie list in alphabetical order:

Click the >> Next button. 

 Exit ListMaker button
Exits ListMaker and jumps back to the screen you were 
viewing before jumping to ListMaker:

Click the Exit ListMaker button.

 ListMaker title
The title identifies the ListMaker.

 Movie text box



Provides a space to type the name of a movie you want 
to include in the current list:

In the Movie text box, type the name of the movie.    

 If you jump to ListMaker from a movie listing, the name of 
that movie as well as its genre and year of release are 
automatically filled in. You can, of course, replace the information 
in the text boxes with information on whatever movie you choose.

 ListMaker alphabetizes the movies, so enter movie titles such as
The Birds as Birds, The. 

How to Add a Movie to a Movie List

 Genre(s) text box
Provides a space to type the genre of the movie you're 
adding to the current list:

In the Genre(s) text box, click an insertion point, and then
type in one or more genres. 

 If you jump to ListMaker from a movie listing, the name of 
that movie as well as its genre and year of release are 
automatically filled in. You can, of course replace the information 
in the text boxes with information on whatever movie you choose.

How to Add a Movie to a Movie List

 How to Add a Movie to a Movie List
1.In the list in the Controller, click the title of the movie list. 

(Use the scroll bar, if necessary, to move through the list.)
2.Click Show List.

(Double-clicking the list title will also select it.)
3. In the Movie text box, click an insertion point, and then 

type the name of the movie.    
4. In the Year text box, click an insertion point, and then type

the year the movie was released.
5.Click Add Movie.    

 If you jump to ListMaker from a movie listing, the name of 
that movie as well as its genre and year of release are 
automatically filled in. You can, of course replace the 
information in the text boxes with information on whatever 
movie you choose.

 ListMaker alphabetizes the movies, so enter movie titles such 
as The Birds as Birds, The. 



 Year text box
Provides a space to type the year of release of the movie 
you're adding to the current list:

In the Year text box, click an insertion point, and then 
type the year the movie was released.

How to Add a Movie to a Movie List

 Comments text box
Provides a space to type comments about the movie 
you're adding to the current list:

In the Comments text box, click an insertion point and 
then type any comments you wish to include.

How to Add a Movie to a Movie List

 Current List box
Lists the names of the movies in the current list, for 
which you can display information:
1.Use the scroll bar at the right (a scroll bar will be present if 

the list is too long for one screen)    to move through the 
movies if necessary.

2.Double-click the name of the movie.

 Example
You can use the ListMaker to create different types of movie 
lists. And, you can print a list to use as a reference at your 
local video store. For example, say you want a list of 
biographical films.
1.You might begin with Malcolm X. Go to Contents, type 

Malcolm, click Malcolm X (1992) and then click Go To 
Subject. The movie listing appears.

2.On the button bar, click ListMaker. The ListMaker appears. 
The name of the movie, its genre, and its year of release 
appear in the movie text boxes on the right.

3.On the Controller, click New List, type Biographies in the 
text box, and then click OK.

4.On the Controller, click Add Movie.
5.Click Exit ListMaker, and then click Yes in the dialog box 

that appears.
The Malcolm X movie listing appears.

6.On the Controller, click Contents.
7. In the text box, type a new title, say chaplin. Click Go To 

Subject. The Chaplin movie listing appears. Click 



ListMaker, and then, on the Controller, click Add Movie.
8.To print the list, click Print List.

 You can, of course, add movies (and comments) by typing 
the information in the text boxes. And it's easy to add new 
movies to any of your lists, to add comments, or to change any of
the information.
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 Title area
The title identifies the Overview screen.

 Display description
The heading identifies the display below as Features, a 
description of the features in Cinemania '94; Credits, a list of 
credits for the information in the product; or Video Sources, 
information on suggested sources for ordering videotapes 
and/or videodiscs.

 Display area
Here you see either a Welcome screen or, depending on which
buttons you click, a description of the features in Cinemania 
'94, a list of credits for the information in the product, or 
information on ordering videotapes and/or videodiscs.
Use the scroll bar to move through the text.

To display the description of the features:

Click Features.
To display the list of credits:

Click Credits.
To display the information on video sources:

Click Video Sources.

Anytime you need help, click the  button in the upper-right
corner of the Controller.

 Welcome button
Displays the Cinemania '94 Welcome screen:

Click Welcome.

 Features button
Displays a description of the features in Cinemania '94:

Click Features.



 Credits button
Displays a list of all sources of the information presented 
in Cinemania '94:

Click Credits.

 Video Sources button
Displays Leonard Maltin's and Roger Ebert's recommended 
sources for ordering videotapes and/or videodiscs.

 Demo button
Displays the opening screen of an animated demonstration
of Cinemania '94:

Click Demo.
The animated demonstration fills the window and, after a 
brief intermission, begins playing.

You can play specific sections of the Demo by clicking the 
buttons at the right (Movies, for example, or Features).

To exit the demo, click the Exit button.

 It is best to play only one media element at a time. If you start
a film clip or a Demo and then want to play something else, 
stop the first element before you start another one.

Credits button
Displays the complete list of sources of the information 
presented in Cinemania '94:

Click Credits. 
The credits information replaces the outline in the display 
area.

To use the outline to find the information you want:
1.Click Outline.

The outline appears.
2.Click the title of the section you want to jump to.

Outline button



Displays the outline of the source credits for Cinemania 
'94:
1.Click Outline.

The outline appears, replacing the full credits information 
in the display.

2.Click the title of the section you want to jump to.

To display the full credits information:

Click Credits. 
The credits information replaces the outline in the display 
area.

 Copy button
Copies the text currently displayed onto the Windows 
Clipboard:

Click Copy.
The text is copied onto the Windows Clipboard.

 Copyright information is automatically appended to the 
copied text. 

How to Paste Text into Another Application

 Print button
Sends the text currently displayed to your printer:

Click Print.

 If you would like to format the text, use Copy instead and then 
paste the text into another Windows application.

 Copyright information is automatically appended to the copied 
text. 

How to Paste Text into Another Application

 Controller display area
This area displays a variety of information in other parts of 
Cinemania '94; however, it displays only a graphic in the 
Overview.
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 Title bar
Identifies the window as Cinemania '94 Help.



 File menu
Displays the Exit command, which you can use to close 
Help:

From the File menu, choose Exit. 

 Help menu 
Displays the Help menu where you can find Viewer 
version information:

Click the Help button.
To see version information on Viewer.

Click About.

 Help Topics button
To jump to the Help Topics screen:

Click the Help Topics button.

 Back button
To go back to the last Help topic viewed:

Click Back.
You can continue clicking Back to backtrack through Help 
topics viewed in the current session (to a total of 40).

 History button
Displays a list of recently visited Help topics which you 
can jump back to:
1.Click History.

The History dialog box appears.
2.Click the title of the Help topic you want to jump to.
3.Click Go To.

 You can also jump to the topic by double-clicking the Help 
topic.

The History dialog box stays open so you can jump to as 
many of the Help topics as you wish. Remember, you can 
use the title bar to drag the box to a new location.



To close the History dialog box when you are through 
using it:

Click Cancel.

 Help Topic title
Here you see the title of the Help Topic you're currently viewing.
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 Text box
Provides a space to type the word or phrase you want to 
search for:

In the text box, type the word or phrase. (It is not 
necessary to use capital letters.)

How to Find All the Occurrences of a Word or Phrase

 How to Find all the Occurrences of a Word or Phrase
1.In the text box, type the word or phrase. 
2.Choose the topics or types of subjects you want to search.

Click All Topic Groups to search all the subjects: movies, 
biographies, and topics.

Click Selected Topic Groups and then, at the right, click 
the topic groups you want to search.

Click Current Topic Only to search only the current topic.
3.Click OK.

 You can narrow your search by typing a combination of 
words and operators. To see examples, click the Hints button.

You can also limit your search to topic titles or to those topics
found in your most recent search. Click the Options button.
Want to repeat one of your recent searches? Click the down 
arrow to the right of the text entry box to see a list and then 
click the search you want to repeat.

 OK button
Begins the search:

Click OK.
The Topics Found dialog box appears with a list of all the

topics (movie reviews, biographies, topical articles, and Academy
Award listings) that contain the word or words you're searching 
for. 
A message appears informing you if no topics are found. 

How to Find All The Occurrences of a Word or Phrase

 Topics Found dialog box
Lists the topics or subjects found in the search and lets 
you jump to any or all of them.
Click on the graphic below to pop up information.



 Minimize button
You probably won't need to minimize the Topics Found 
dialog box. If you do, you may have a hard time finding it. 
To display the icon for the minimized Topics Found dialog 
box, press Alt+F6. Then, to display the Topics Found box, 
double-click the icon.

 List of previous search requests
Displays a list of previous search requests which you 
can repeat:
1.Click the down arrow.

A list of your previous searches appears.
2.Click the search you want to repeat.
3.Decide which topics you want to search.

Click All Topic Groups to search all the topics.

Click Selected Topic Groups and then, at the right, click a
check box in front of each topic group you want to search.

Click Current Topic Only to search only the current topic.
4.Click OK.

 Search In options
Lets you select the topic groups you want to search:

Click All Topic Groups to search all the subjects: 
movies, biographies, and topics.

-or-



Click Selected Topic Groups and then, at the right, click 
the check box in front each topic group you want to search.

-or-

Click Current Topic Only to search only the current 
topic.

 You can also limit your search to just those topics found in 
your most recent search. Click the Options button to use the 
Options dialog box.

How to Find All The Occurrences of a Word or Phrase

 Options button
Displays options for narrowing your search:

Click Options.
The Find Options dialog box appears.

Click below to pop up information.
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 Title bar
Identifies the window as Find Options.

 Find Options
Lets you choose whether to search only the topics 
found in your most recent search:

Click List of Previous Topics Found, and then click OK. 
Find Word then searches only the topics found in your last 
search for the word or phrase you've specified. This option is 
helpful when you want to narrow down your search even further.

Searching the Topic Titles Only is not an efficient way to 
search. If you want to find the title of a movie, search Movies
for a key word or words. For example, if the title contains the
word commando, type commando in the text entry box, 
make sure Movies is the only Topic Group selected, and 
then click OK. 
If the title contains the words far and crowd, type far near 
crowd. (You find Far From the Madding Crowd.)
If the word you remember is a common one, try to think of 
some other key word that would most likely appear in the 
text. For instance, you remember the word sky and that the 
movie is set in a desert. Type sky and desert. Among the 
topics found will be the movie The Sheltering Sky.



 OK button
Sets the options you've checked in the Find Word 
Options dialog box:

Click OK.

 Cancel button
Closes the Find Word Options dialog box without setting 
any options:

Click Cancel.

 NEAR parameter
Lets you tell Find Word how near to each other two 
separate words or phrases have to be:

Enter the number you want in the "NEAR means 
within [              ] words" box. The number 8 is the default.

For example, to find the Clint Eastwood movie that has the 
word bad and the word ugly in the title, you could type bad 
near ugly in the Search by Word box, and set the NEAR 
parameter to 6.
To find words appearing right next to each other, set the 
number to 1.

  Example
Let's say that you want to browse through movies about 
Sherlock Holmes. 
1.Click Find Word.
2. In the text box, type "sherlock holmes" (include the 

quotation marks).
3.Click Selected Topic Groups. (You don't need to search 

through all of the topics.)
4.Under Topic Groups, click Movies and Biographies.
5.Click OK.

The Topics Found dialog box appears, listing the topics in 
which the phrase sherlock holmes appears.

Now you can browse through the subjects and then, if you 
like, narrow the list to include only biographies.
1. In the Topics Found dialog box, click To Find. The Find 

Word dialog box appears again.
2.Click the arrow to the right of the text box.



3.In the list that appears, click "sherlock holmes".
4.Under Topic Groups, click Movies to deselect it, leaving only

Biographies checked.
5.Click OK.

The Topics Found dialog box appears again, this time listing
biographies and filmographies.
The Topics Found dialog box stays open, so you can jump 
from subject to subject.

 Hints button
Displays a summary of the different ways to combine 
words and operators:

Click Hints.
A summary of Hints appears describing the ways you 

can set up your search request. 
Click More Hints below to see movie-specific examples of 
Find Word requests using combinations of words and 
operators.
More Hints

 More Hints
Search Phrase Topics Found

star wars Topics with "star" and with "wars"
"star wars" Topics with the phrase "star wars"

look*    Topics with "look," "lookalike," 
"looked," "looking," and "looks"

hepburn tracy Topics with "hepburn" and "tracy" 
"spencer tracy" AND
"katharine hepburn"      

Topics with "spencer tracy" and 
"katharine hepburn" 

hepburn tracy comedy Topics with "hepburn" and "tracy" 
and "comedy"

hepburn NOT tracy Topics with "hepburn" but not "tracy"
bad NEAR ugly (If, for

instance, you can't
remember the complete

title of The Good, the
Bad, and the Ugly)

Topics with "bad" and "ugly" if the 
words are no more than a specified 
number of words apart in the text 
(the default is 8). To set the number, 
click Options in Find Word and enter
the number in the NEAR Means 
Within box (1 = words next to each 
other).

"meg ryan" OR "goldie
hawn" AND comedy 

Topics with "Meg Ryan" or "Goldie 
Hawn" and "comedy"

 Cancel button
Cancels the search and closes the Find Word dialog 



box:

Click Cancel.

 Help button
Displays this Help screen:

Click Help.

  Topics Found title
The title identifies the Topics Found dialog box and tells you 
how many topics contain the word or phrase in your search 
request.

 Search request
Here you see the word (or words) you used in your current 
search request. This word (or words) appears in all of the 
topics in the list below.

 List of topics found
Displays the list of topics found in the search, to which 
you can jump:
1.Use the scroll bar to move through the list if necessary, and 

then click the topic title.
2.Click Go To.

The topic appears.

 You can also double-click the title to jump to the topic.
For your convenience in looking for topics, the Topics Found 
dialog box stays open until you close it. 

To close the Topics Found dialog box:

Click Cancel.
How to Jump to a Topic (Subject)

  How to Jump to a Topic (Subject)
1.In the Topics Found dialog box, use the scroll bar to move 

through the list (if necessary), and then click the topic title.
2.Click Go To.

 You can also double-click the title to jump to the topic.



For your convenience in looking for topics, the Topics Found 
dialog box stays open until you close it. 

To close the Topics Found dialog box:

Click Cancel.

 Go To button
Takes you to the selected topic:

Click Go To.
The topic appears.

How to Jump to a Topic (Subject)

 To Find button
Displays Find Word again so you can create another 
search:
1.Click To Find.

The Find Word dialog box appears.
2.Click the down arrow to the right of the text box.
3. In the list that appears, click the search request you want 

to repeat.
4.Change the request, if you wish, by adding or subtracting 

words or operators, or by selecting different topic groups to
search. (The original search request remains in the list.)

5.Click OK.
The Topics Found dialog box appears again, listing the 
topics that meet your search criteria.

 Cancel button
Closes Topics Found:

Click Cancel.

 Previous Match button
Jumps to the topic listed just before the current topic:

Click Previous Match.

 Next Match button



Jumps to the topic listed just after the current topic:

Click Next Match.
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 Copy button
Copies the text currently displayed in the Copy dialog 
box onto the Clipboard:

Click Copy.
The text in the Copy dialog box (movie listing, biography, 
topic, or Academy Award listing) is copied onto the 
Clipboard.

 Copyright information is automatically appended to the 
copied text. 

How to Copy Text
How to Paste Text into Another Application

 How to Copy Text
1.Go to the subject (movie listing, biography, or topic) or 

Academy Award listing you want to copy.
2.Above the display area, click Copy.

The Copy dialog box appears, displaying the text of the 
current subject or Academy Award listing.

3. If you don't want to copy all of the text, select that portion 
you do want to copy.

4.Click Copy.
The text in the Copy dialog box    is copied onto the 
Windows Clipboard.

 Copyright information is automatically appended to the 
copied text. 

How to Paste Text into Another Application

 Cancel button
Cancels Copy:

Click Cancel.
The Copy dialog box closes.

 Even though you click the Cancel button, the text of the 
subject is still copied onto the Clipboard, replacing the text 
copied previously.

 Text box
Displays the text of the current subject or Academy 
Award listing, which you can copy onto the Clipboard:



If you don't want to copy all of the text, select that portion
you do want to copy.

How to Copy Text
How to Paste Text into Another Application

 Example
1.Go to Steel Magnolias.
2.On the Controller, click Maltin.
3.Above the display area, click Copy.

In the Copy dialog box, select that portion of the text you 
want to copy.

4.Click Copy.
The text in the Copy dialog box is copied onto the 
Windows Clipboard.

5. In the review, click Dolly Parton to jump to Dolly Parton's 
biography.

6.From the Options menu, choose Annotate.
7. In the Annotate dialog box, click Paste, and then click 

Save.
The text you copied from Steel Magnolias is now an 
annotation on the Dolly Parton biography (a  appears at
the top of the biography.

 Copyright information is automatically appended to the 
copied text. 

How to Paste Text into Another Application
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 Default Printer
This identifies the printer that Cinemania '94 will use, unless 
you select a different one from the Specific Printer list.

 Specific Printer list
Installs a specific printer instead of the current default 
printer:
1.Click Specific Printer.
2.Click the arrow to the right of the Specific Printer box.
3.Click the printer you want to use.
Occasionally, you may get an error message if you try to print 
to a specific printer or the text may be sent to the default 
printer anyway. If this occurs, use the Control Panel in the 
Windows Program Manager to change printers.

How to Change the Default Printer

 How to Change the Default Printer
1.In a Cinemania '94 window, click the Control-menu box, 

choose Switch To, click Program Manager, and then click 
Switch To.

2.Double-click the Control Panel icon. 
3.Double-click the Printers icon.
4. In the Installed Printers list, use the scroll bar, if necessary, to 

move through the list, click the printer you want as the default, 
and then click Set As Default Printer.

5.Click the Control-menu box in the upper-left corner of the 
Printers dialog box, and then click Close.

6.Click the Control-menu box in the upper-left corner of the 
Control Panel box, and then click Close.

7.Click the Control-menu box in the upper-left corner of the 
Program Manager window, choose Switch To, click Microsoft 
Cinemania '94, and then click Switch To.

 Orientation
Lets you select the orientation of text on
your printed page:

Click Portrait if you want your pages printed in the 
usual way, so that you have a long, narrow page.

-or

Click Landscape if you want your pages printed so 
that you have a short, wide page.



 Orientation
Lets you select the orientation of text on
your printed page:

Click Landscape if you want your pages printed so 
that you have a short, wide page.

-or

Click the Portrait button if you want your pages 
printed in the usual way, so that you have a long, narrow 
page.

 Paper Size
Sets the printer for a different size of paper:
1.Click the arrow to the right of the Paper Size box.

The list of available paper sizes appears. The default is the 
familiar 8.5 x 11 inch size.

2.Click the size you want.

 Paper Source
Sets the source of paper for your printer:
1.Click the arrow to the right of the Paper Source box. A list of

available sources appears. The upper tray is usually the 
default. 

2.Click the source you want.

 OK button
Saves your changes and closes the Print Setup dialog 
box:

Click the OK button.
 

 Cancel button
Closes the Print Setup dialog box without changing 
anything:

Click the Cancel button.



 Options button
Displays Print Options for the currently selected printer, 
which you can change:
1.Click the Options button.

The Options dialog box appears.
2.Select the options you want.

 See your Microsoft Windows documentation for information
on using print options. See the documentation that came with 
your printer for information specific to your printer.
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 Save button
Saves the annotation and closes the Annotate box:

Click Save.
The annotation is saved.

How to Add an Annotation 

 Cancel button
Closes the Annotate box without adding or changing an 
annotation:

Click Cancel.
The Annotate box closes and the annotation is not added 

to the subject (movie listing, biography, or topic) or the Academy 
Award listing.

 Delete button
Deletes the text in the Annotate box and removes the 
annotation from the subject or the Academy Award listing:

Click Delete.

 Copy button
Copies the text in the annotation onto the Clipboard:

Click Copy.
The text is copied onto the Clipboard.

How to Paste Text into an Annotation

 

 Paste button
Pastes the contents of the Clipboard into the 
Annotation dialog box:

Click Paste.
The contents of the Clipboard are pasted into the 
annotation.

How to Add an Annotation
How to Paste Text into an Annotation

 



 How to Add an Annotation
1.Jump to the subject (movie listing, biography, or topic) or 

Academy Awards listing you want to annotate.
2.From the Options menu, choose Annotate.
3.Type the annotation in the text box.
4.Click Save.

The annotation is added to the subject.

The annotation icon  appears either above the text of 
the annotated subject or, if you've annotated a gallery item, 
next to its caption. 

To display an annotation:
1.Go to the subject or Academy Award listing with the 

annotation.

2.Click .
The annotation appears. You can edit the text and then 
save the revised annotation.

 How to Paste Text into an Annotation
1.Open the application (Microsoft Word for Windows, for 

example) and select the text you want to copy.
2.From the Edit menu, choose Copy.
3.Click the Control-menu box in the upper-left corner of the 

window, choose Switch To, click Cinemania '94, and then 
click Switch To.

4.Go to the subject or the Academy Award listing with the 
annotation you want to add the text to.

5.Click the icon , and then click Paste.
6.Click Save.

To paste text from an existing annotation into a new one:
1.Jump to the subject (movie listing, biography, or topic) or 

Academy Award listing with the annotation you want to 
copy.

2.Click the icon , and then click Paste.
3. Jump to the subject or Academy Award listing with the 
annotation you want to paste the text into.
4. From the Options menu, choose Annotate.
5. Click Paste.
6. Click Save.

 Annotation text box
Provides a space to type or copy the text you want as 
an annotation to the current subject:



1.Type the annotation in the text box. If you make a 
mistake, press the Backspace key to erase any 
unwanted characters, and then continue typing. Text 
wraps automatically, but you can end a line before it 
wraps by pressing Enter.

2.Click Save.

Pasting text into an Annotation

 Example
Say you want to add your own review to Kenneth Branagh's 
Henry V, for instance, and also add information from his 
biography. First, create your annotation.
1.On the Controller, click Contents, and then in the text box 

above the Contents list, type henry. Click Henry V (1989),
and then click Go To Subject.

2.From the Options menu, choose Annotate.
3. In the Annotate text box, type your review.
4.Click Save.

The annotation is added to the subject and  appears 
next to the caption.

Now, add information from Branagh's biography.
1.On the Controller, click Maltin, and then in the review, 

click Kenneth Branagh. The biography appears.
2.Above the biography, click Copy.
3. In the Copy dialog box, select the text you want, and then 

click Copy.
4. In the button bar, click History, in the History dialog box, 

click Henry V (1989) Still, and then click Go To. The movie
listing, with the movie still on display, appears.

5.Click  in the caption area. The Annotation dialog box 
appears, with the text of your review.

6. Click an insertion point, click Paste, and then click Save.
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 Button bar (top of window)
Award List =Alt+A
Back = Alt+B
Find Word = Alt+F
Gallery = Alt+G
Options = Alt+I
History = Alt+S
ListMaker = Alt+M

 Button Bar (display area)
Article = Alt+E
Print = Alt+P
Review = Alt+R
Outline = Alt+U
Awards = Alt+W
Copy = Alt+Y

 Controller buttons (global)
Contents = Alt+C
Credits = Alt+D
Help = Alt+H, alt+?, Alt+/, F1
List = Alt+L
Next subject or listing (>>) = Alt+>, Alt+(Period).
Previous subject or listing (<<) = Alt+<, Alt+(Comma),

 Controller buttons (Movie Listings)
Maltin = Alt+1
Ebert = Alt+2
Baseline = Alt+3
Kael = Alt+4
Cast List = Alt+5
Credits = Alt+6
Movie Still = Alt+7
Dialogue = Alt+8
Film Clip = Alt+9
Music = Alt+0

 Controller buttons (Biographies)



Biography = Alt+1
Filmography = Alt+3
Awards = Alt+6

 Controller buttons (Topics)
Definition = Alt+1
Topical Article = Alt+3

 Controller buttons (Award List)
Year = Alt+7
Category = Alt+9
Exit Award List = Alt+X

 Controller buttons (Gallery)
Show Media = Alt+1
Go To Subject = Alt+3
All Media = Alt+5
Portraits = Alt+6
Movie Stills = Alt+7
Dialogue = Alt+8
Film Clips = Alt+9
Music = Alt+0
Exit Gallery = Alt+X

 Controller buttons (ListMaker)
Show List = Alt+1
Print List = Alt+5
Add Movie = Alt+7
New List = Alt+8
Delete Movie = Alt+9
Delete List = Alt+0
Exit ListMaker = Alt+X

 Controller buttons (Overview)
Features = Alt+1
Credits = Alt+3
Demo = Alt+6



Video Sources = Alt+7

 Contents dialog box
All Contents = Alt+A
Biographies = Alt+B
Cancel = Alt+C
Go To Subject = Alt+G
Help = Alt+H, Alt+?, Alt+/
Movies = Alt+M
Topics = Alt+T



 Options Menu
Annotate = Alt+I+A
About Cinemania = Alt+I+B
Print Setup = Alt+I+R
Set Colors = Alt+I+C

 Find Word dialog box
All Topic Groups = Alt+A
Cancel = Alt+C, Esc
Help = Alt+H, Alt+?, Alt+/, F1
Hints = Alt+I
OK = Alt+K
Selected Topic Groups = Alt+L
Current Topic Only = Alt+N
Options = Alt+O
Topic Groups = Alt+T+Arrow keys
Word = Alt+W
Previous search requests = Spacebar

 Find Word Options dialog box
Cancel = Esc
OK = Enter

 Find Word Hints dialog box
OK = Enter



 Topics Found dialog box
Cancel = Esc
To Find = Alt+F
Next Match = Alt+N
Previous Match = Alt+P



 History dialog box
Cancel = Esc
Go To = Enter



 Hot Text Color dialog box
Cancel = Esc
OK = Enter

 Copy dialog box
Cancel = Esc
Copy = Alt+C

 Print dialog box
Cancel = Alt+C, Esc

 Annotate dialog box
Cancel = Esc
Copy = Alt+C
Delete = Alt+D
Paste = Alt+P
Save = Alt+S

 Scrolling 
Down one screen = Page Down  
Up one screen = Page Up
Down one line = Down Arrow
Up one line = Up Arrow

 Help window
File menu = Alt+F

Exit = Alt+X
Help menu = Alt+H

About = Alt+A
Help Topics button = Alt+T
Back button = Alt+B
History button = Alt+S

{ewl MvBmp2, ViewerBmp2, !helpterm.shg}



To display a pop-up 
definition of a term, click 
the term.
To close the pop-up 
window, click outside the 
popup.

>> Next button
<< Previous 
button
active
annotation
arrow keys
browse
button bar
caption
click
Clipboard
Contents
Control menu
Control-menu 
box
Controller
copy
cursor
default
demo

desktop
dialog box
double-click
drag
filmography
filter
gallery item
graphic
Hints button
hot, hot spot
icon
jump
Maximize button
maximize
Minimize button
minimize
movie still
MPAA Rating
>> Next button

operators
outline
paste
pop-up window
<< Previous 
button
printer driver
Program 
Manager
Restore button
scroll bar
section heading
section
select
star rating
topic
Viewer
window
wrap

 >> Next button 
A button at the bottom of the Controller you can click to 
display the subject following the current subject.
For example, if you are viewing a movie listing, the >> Next
button takes you to the next subject in the current Contents 
list (that is, the list you created using the buttons and filters 
in the Contents dialog box).
If you are viewing an Award list, the >> Next button takes 
you to the next award category or year in the list.

 << Previous button 
A button at the bottom of the Controller you can click to display 
the subject preceding the current subject.
For example, if you are viewing a movie listing, the << Previous 
button takes you to the previous subject in the current Contents 
list (that is, the list you created using the buttons and filters in 
the Contents dialog box).
If you are viewing an Award list, the << Previous button takes 
you to the previous award category or year in the list.



 active
Describes the currently selected window or icon. Your 
commands and keystrokes apply only to the active window or 
icon. You click the window or the icon to make it active.
An active window usually appears in front of all other windows 
on the desktop and its title bar changes color when it becomes 
active. 
When you click an icon to make it active, its Control-menu 
appears.    
Inactive is the opposite of active and describes windows or 
icons that are not selected.

 annotation
A note or comment of your own that you add to a subject (movie
listing, biography, or topic) or an Academy Award listing.    

 arrow keys
Keys you can use to control the movement of the insertion 
point on the screen. Some keyboards have two sets of arrow 
keys: one on the numeric keypad and another set to the left of
that area. If you use the arrow keys on the numeric keypad, 
be sure to turn the number lock (Num Lock) off.

 browse
To use browse buttons (<< Previous and >> Next) to display 
subjects (movie listings, biographies, and topics), gallery 
items, and any other items in sequential lists rather than 
jumping directly to a specific subject, gallery item, or list 
item.
The Previous and Next buttons act on the current list of 
subjects or the current list of Academy Awards, which you 
created in the Contents dialog box.
For example, you can use browse buttons to browse through
the Contents list, the MultiMedia Gallery list, and the 
Academy Awards list.

 button bar
In Cinemania '94, the button bar that always appears at the 
top of the window is the main button bar.
Other buttons may appear at the top of the display area. For 
instance, when the text of a subject such as a review, a 
biography, or a topical article is displayed, you see a short 
button bar above the display.



The Help button bar appears at the top of the Help window. 

 caption
The descriptive text that accompanies a photo, dialogue 
excerpt, music excerpt, or film clip.

 click, double-click
To click means to press and release a mouse button in one 
nonstop motion.
To double-click means to press and release a mouse button 
twice in rapid succession.
In Cinemania '94, you click buttons, commands, hot text, and 
list items.
Double-clicking is an option for list items only. For example, to
go to a movie listing from the Contents list, you click the title 
of the movie, then click Go To Subject. However, you can 
choose to double-click the title instead.

 If you double-click an audio icon  to play a dialogue or 
musical excerpt, the first click starts the excerpt and the second 
click immediately causes it to pause. Be sure to single-click.

 Clipboard
In Microsoft Windows, a temporary storage area for cut and 
copied text or graphics.    You can paste the contents of the 
Clipboard into a file in another Windows application, such as 
Microsoft Excel, Microsoft Word for Windows, or Microsoft Write.

 Contents dialog box
The dialog box that contains a list of all the subjects (movie 
listings, biographies, and topics) in Cinemania '94. You use it 
to first find your subject, and then to jump to it. The Contents 
dialog box also contains buttons and filters, which you can 
use to sort or narrow down the list of subjects. Then when 
you are browsing through Cinemania '94, you can display 
this sorted list by clicking List on the Controller. 
You can also use the << Previous and >> Next buttons to 
browse through the subjects in the Contents list.
See browse.



 Controller

The graphic representation of a remote control that you 
see on Cinemania '94 screens. It is equipped with 
buttons that you click to display information or media, to 
change the lists in dialog boxes, or to jump to other 
parts of the program. The buttons and the display area 
at the top of the Controller change, depending on which 
feature you're using. 
Always single-click buttons on the Controller

 Control menu
A menu containing general Windows commands that you use to 
move, resize, shrink, and close windows. It also contains a 
command that you use to switch to other programs. 

 
To open the Control menu, click the Control-menu box in the upper-
left corner of the window.

 Control-menu box
The icon (symbolized by a spacebar) that appears at the far left
in the title bar. Click it to open the Control menu for that 



window.

 copy
Copies the text currently displayed onto the Windows
Clipboard.
When you click a Copy button, the Copy dialog box appears. If
you don't want to copy all of the text, you can select that part 
you do want to copy, and then click Copy.

After the text is copied onto the Clipboard, you can open a file 
in another Windows application, click an insertion point, and 
then choose the Paste command from the Edit menu. 

 Cinemania '94 has a handful of very long articles that are too
long for the Copy dialog box. The article may be truncated. The 
Baseline review of Gone With the Wind is an example of such an 
article. To copy these long articles, press Ctrl+C to copy the text 
directly to the Clipboard..

.

 cursor
The blinking line or pointer that marks the current entry 

point. The cursor changes from a pointer  to a hand  
when you move it on top of hot text.

 default
In computer terminology, an option that is preset for the 
user. You can change most defaults to meet your needs. 
For example, the default color of the hot text in Cinemania 
'94 is blue. You can change the default if you like by 
choosing Hot Text Color from the Options menu and then 
choosing a different color for the hot text. 

 Demo
The animated introduction to the key features in Cinemania '94.

 It is best to play only one media element at a time. If you start 
a film clip or a Demo and then want to play something else, stop 
the first media element before you begin another one.

 desktop



The background of your screen, on which windows, icons, 
and dialog boxes appear.

 dialog box
A box which displays special lists or options from which you 
can choose.
In Cinemania '94, a dialog box appears when you click certain
buttons on the Controller or the button bars. Depending on 
the button you've clicked, the dialog box displays special lists 
or options from which you make your choice.
For example, click Contents on the Controller to see the 
Contents dialog box, which presents the Contents list plus 
buttons and filters you can use to narrow down the list.

 drag
To move an object on the screen, such as the scroll box on 
the scroll bar, by pointing to it, holding the mouse button 
(usually the left one), dragging the object to a new location, 
and releasing the mouse button.

 film clip
In Cinemania '94, a scene from a movie. The excerpts were 
chosen from films representing the best of nine decades of 
movie making:
1910s The Birth of a Nation (1915)
1920s Son of the Sheik (1926)
1930s My Man Godfrey (1936)

Gone With the Wind (1939)
1940s Casablanca (1942)

Life With Father (1947)
1950s The African Queen (1951)

High Noon (1952)
Ben Hur (1959)

1960s Becket (1964)
2001: A Space Odyssey (1968)
Butch Cassidy and the Sundance Kid (1969)

1970s The Godfather (1972)
One Flew Over the Cuckoo's Nest (1975)
Star Wars (1977)

1980s Amadeus (1984)
iss of the Spider Woman (1985)
Platoon (1986)

1990s Dances With Wolves (1990)
The Silence of the Lambs (1991)



filmography
A list of a person's movie credits.

 filter
A feature in the Contents dialog box that you can use to 
temporarily screen out subjects you do not want, so you can 
search more efficiently. For instance, if you're searching for 
movie listings, you can screen out movies in all of the genres 
except comedy. Or, you can screen out all the movies that 
don't have Goldie Hawn performing in them. 

 Note that the filters all work together. Check all the filters to 
make sure you're not excluding movies from the Contents list that 
you really want to include. To clear all the filters, click Reset All. 

 Gallery items
In the MultiMedia Gallery, the pictures, dialogue and music 
excerpts, and film clips.
The icons identifying the gallery items are:

Movie still Portrait Film clip

Still+Dialogue Dialogue 
excerpt

Musical 
excerpt

 It is best to play only one media element at a time. If you start a 
film clip and then want to play a Demo or some other gallery item, 

click  first.
How to View a Full-Screen Film Clip

 graphic
An illustration, graph, diagram, or photograph.

 Hints button
The button in the Find Word dialog box you can click to open
the Hints dialog box. There you see a list of the operators 
you can use to narrow down your search for occurrences of 
words or phrases. You also see examples of how to use the 
operators.



 hot, hot spot
Areas on the screen, such as emphasized text or icons, are 
sometimes hot. When you move the cursor over a hot spot, the 

cursor changes from  to .
You can click a hot spot to display a pop-up definition or 
explanation, or you can click text emphasized with a different color 
(normally blue) to jump to another part of the program. 
For example, in a movie listing, the icons at the top of the Controller 
are hot. Click one and you pop up an explanation of that icon. 
Another example is a star rating. Many reviews include a star rating 
from the reviewer. Click the stars and you pop up an explanation of 
the rating.

 icon
A small graphic reproduction of an object, a concept, or a 
message. In Cinemania '94, several icons appear in the 
display area of the Controller when a movie listing is on 
display. 
Another example is an application icon on your desktop, such 
as the icon representing Cinemania '94, below. 

 jump
To move to a different place in Cinemania '94, usually by 
clicking an item in a list or by clicking a hot spot (an icon, or 
text that is emphasized with a contrasting color.

 maximize
To enlarge a window to its maximum size by clicking the 
Maximize button in the upper-right corner of the window, or by 
choosing the Maximize command from the Control menu.

 

 Maximize button
One of the buttons in the upper-right corner of a window. 
You click it to enlarge a window to its maximum size.

 



 minimize
To reduce a window to an icon by clicking the Minimize button 
in the upper-right corner of the window, or by choosing the 
Minimize command from the Control menu.

 Minimize button
One of the buttons in the upper-right corner of a window. 
You click it to reduce a window to an icon on the desktop.

 Movie still
A publicity photograph taken on the set of a movie.

 MPAA rating 
A rating given to a movie by the Motion Picture Association of 
America as a guide to indicate the type of audience for whom 
the movie is suitable. For example, a G rating means the film is 
suitable for general audiences, and an R rating means the film is
restricted, no children under 17 admitted unless accompanied 
by an adult. MPAA ratings began in 1968, so no film released 
prior to that will have an MPAA rating. Made-for-television 
movies also do not have MPAA ratings.
When you are looking at a movie listing, you can click the MPAA
icon in the Controller window to pop up an explanation of the 
rating. You can then click More Info in the MPAA popup to 
display a full list of the ratings.

 operators
The words AND, OR, NOT, and NEAR, which you type in the 
Find Word text box to tell Find Word how to organize your 
search. For instance, AND used between one word and 
another or one phrase and another, tells Find Word to search 
for only those topics (subjects such as movie listings, 
biographies, and topics plus Award List information) that 
contain both words, not one or the other. For example, type 
ivory and forster and then click OK, and you get a list of 
subjects containing both ivory and forster.



outline
In a lengthy Cinemania '94 movie review or topical article, a 
list of the section headings. Or, in the Award List, a list of 
Academy Award categories or years. The outline gives an 
overview of the    subject's content and organization and lets 
you jump directly to the information you want. Click a section 
heading and you jump directly to that section. 

 paste
In Microsoft Windows, to use the Paste command on the Edit 
menu to insert cut or copied text or objects into another 
Windows application from the temporary storage area called 
the Clipboard.

You use the Copy button, which appears above text display 
areas in Cinemania '94, to copy text onto the Clipboard.

 popup, pop-up window
A window you display by clicking a hot spot. The popup contains 
supplementary information such as a definition, an explanation, 
or an example. The pop-up window has no title bar or Control-
menu. 
To close the pop-up window, you click outside the popup in an 
area that is not hot.

 printer driver
A file that provides printer fonts and printing instructions for the 
printer.

 Program Manager
Your home base for using Windows and starting applications. 
When you start Windows, the Program Manager window is open
on the desktop.

 Restore button
When a Cinemania '94 window has been resized, and then 
maximized, a Restore button replaces the Maximize button 
in the upper-right corner of a window. Click the Restore 
button to restore the window to its previous size.



 scroll bar
A tool for moving vertically (and sometimes horizontally) 
through a window with the mouse. In Cinemania '94, a 
vertical scroll bar appears to the right of articles and lists 
when they are longer than the length of a single screen.
Scroll bars are located at the far right and/or the bottom 
edges of a window.

 section
A separate part or division. In Cinemania '94, long movie 
reviews are divided into sections and each section has a 
heading in the outline. In an outline, you click a section 
heading to jump to that section.

 section heading
The title of a section in an outline. In Cinemania '94, long 
movie reviews are divided into sections and each section has 
a heading in the outline. Also, the Award List provides an 
outline, organized by both categories and years. In an outline,
you click a section heading to jump to that section.

 select
To highlight text or commands so that you can act on them. For 
example, to copy text onto the Clipboard you first select it by 
pointing to the beginning of the text, holding down the left mouse 
button, dragging the highlight to the end of the text, and then 
releasing the mouse button.

Star ratings
At the top of a review in Cinemania '94, you will see the star 
rating given to the movie by the reviewer, which can be Leonard 
Maltin, Roger Ebert, or Baseline. (Pauline Kael doesn't believe 
in star ratings.) The star rating also tells you how many stars are



possible from that particular reviewer. For example, Leonard 
Maltin's highest rating is four stars, so four stars appear in grey. 
If the movie rates only two stars, two of the four will appear in 
red. For made-for-television movies, Leonard Maltin gives 
ratings of Below Average, Average, and Above Average.
Click the rating and you pop up an explanation.
In Contents, the Star ratings filter uses Maltin's ratings, because 
Maltin reviews every film in Cinemania '94.

 topic
The heart of Cinemania '94 is the information found in the 
movie listings, biographies, and topics. A topic can contain an 
article about a subject relating to the movie industry, movie 
history, or movie making; a definition of a film term; or both. For 
example, special effects is a topic made up of an article, film 
theory is a topic made up of a definition, and film noir is a topic 
made up of both an article and a definition.
Also, in the Find Word dialog box, the term topic is used to refer
to a subject in Cinemania '94, whether it is a movie listing, a 
biography, a topical article, a definition, or an Academy Award 
listing. The term Topic Groups is used to refer to subject groups
you can select for your search.
Also, in Help, all of the information on a specific subject is 
contained in a Help topic.

 Viewer
The Microsoft computer software program that displays 
multimedia products such as Cinemania '94.

 window
The rectangular area on your screen in which you view an 
application or a file. You can have several windows open at 
one time and arrange them to suit your needs. You can 
move them and resize them and you can view more than 
one window at one time. 

 wrap
In computer terminology, when text typed by the user 
automatically continues from one line to the next, it is said to 
wrap.

{ewl MvBmp2, ViewerBmp2, !Q&A.shg}



Single-clicking vs. Double-clicking

What do I single-click in Cinemania '94 and 
what do I double-click?

In Cinemania '94, you single-click almost everything:
buttons, commands, hot text, icons, and list items. 
The only time you must double-click is when you are
in the ListMaker and you want to edit information 
about a specific movie in one of your movie lists. 
You must double-click the name of the movie in 
order to display the information. 
In addition, double-clicking is an optional shortcut. 
You can double-click items in lists. For example, to 
jump to a movie listing from the Contents list, you 
ordinarily click the title of the movie, then click Go To
Subject. However, you can choose to double-click 
the title instead.
You can also double-click the Control-menu box in 
the upper-left corner of a window or dialog box to 
close the window or dialog box.
When in doubt, always single-click.

 Be sure to only single-click the audio icon  to 
play a dialogue or musical excerpt. If you double-click 
the icon, the first click starts the excerpt and the second 
click immediately causes it to pause. 

Where do I click to close a popup?
To close a single popup, click outside the front 
popup in an area of the screen that is not hot. 
When you have layers of popups in your window, 
close the front popup by clicking in the popup just 
behind it (in an area that's not hot).
To close all of the open popups, click outside all of 
them (in an area that's not hot). 

Closing Windows and Popups

How do I make sure I'm closing the right 
window?

In Microsoft Windows, you can have several 
windows open at the same time. Generally, in 
Cinemania '94, it is best to close windows in reverse
order; the last one opened is the first one closed.

Click the Control-menu box in the upper-left 
corner, and then click Close. (Or, double-click the 



Control-menu box).

How do I close a window that is not visible 
on the desktop?

1.Click the Control-menu box, and then choose 
Switch To.

2. In the Task List box, click the title of the open 
application, and then click End Task.

How can I be sure I'm closing the right 
popup?

To close a single popup, click outside the front 
popup in an area of the screen that is not hot. 
If you have layers of popups in your window and 
want to close the front one, click in the one just 
behind it (in an area that's not hot. 
If you want to close all of the open popups, click 
outside all of them (in an area that's not hot.

Copying Text

How do I copy an extremely long article?
A handful of the articles in Cinemania '94 are 
extremely long, too long in fact for the Copy dialog 
box. If you try to copy an article and find that the text
is truncated, use Ctrl+C to copy the text onto the 
Clipboard, rather than clicking the Copy button.
Here is a list of some of the articles which are too 
long for the Copy dialog box:

Gone With the Wind (Baseline review)

Documentary (topical article)

Video Sources (Overview screen)

Copyright Notices 
How to Copy Text
How to Paste Text into Another Application

Why can't I copy any of the pictures from 
Cinemania '94?

Because of licensing restrictions, you cannot copy or
print pictures or other media.

Printing Text

What can I do if I can't print text from 



Cinemania '94?
Here are some things to check:

Try printing from another application to see if the
problem is global.

If you can't print from another application, make 
sure that your printer is plugged in, turned on, and that it
is connected to your computer.

See if you need to change a ribbon, mount a 
print wheel or cartridge, add toner, or add paper.

Make sure you have the correct cable for your 
printer and that the printer cable is properly connected.

From the File menu, choose Print Setup and 
make sure your printer is selected. If it isn't, use the 
Control Panel to install it. (See your Windows 
documentation for information on installing a printer.)

If you have a serial printer, click the Control 
Panel icon in the Program Manager Main group window,
choose Ports from the Settings menu, and check the 
settings.

Click the Control Panel icon in the Program 
Manager Main group window, click the Printers icon, 
and, in the Printers dialog box, make sure the correct 
port is specified.

What can I do if the text I print from 
Cinemania '94 is garbled?

Here are some suggestions:

Turn the printer off and then on to reset it.

Copy the text onto the Windows Clipboard, open
a word processing program such as Microsoft Word for 
Windows, open a file, choose Paste from the Edit menu,
format the text as you wish, and then choose Print from 
the File menu.

Choose Print Setup from the File menu, and 
then make sure the right printer and, if you are using a 
font cartridge, the right font cartridge are selected.

If you have a serial printer, click the Control 
Panel icon in the Program Manager Main group window,
choose Ports from the Settings menu, and make sure 
the baud rate and printer parameters are set according 
to manufacturer's specifications. Decreasing the baud 
rate may solve the problem.



Try reinstalling the printer driver.

How can I format the text I copy from 
Cinemania '94 before I print it?

When you use a Print button in Cinemania '94, the 
text is sent to your printer just as it is formatted on 
the screen. You may wish to format it differently. If 
you wish to format it yourself, use the Copy 
command and paste the text into another Windows 
application.
How to Copy Text
How to Paste Text into Another Application

Why can't I print any of the pictures from 
Cinemania '94?

Because of licensing restrictions, you cannot copy or
print any of the pictures or other media that appear 
in Cinemania '94.

Playing Film Clips

How were the film clips in Cinemania '94 
selected?

Short excerpts were taken from some of the most 
significant films in the history of American cinema. 
(Of course, availability for licensing was also a 
factor.) In future versions of Cinemania, excerpts 
from different films will be included. Following is a 
chronological breakdown of these films:

1910s The Birth of a Nation (1915)
1920s Son of the Sheik (1926)
1930s My Man Godfrey (1936)

Gone With the Wind (1939)
1940s Casablanca (1942)

Life With Father (1947)
1950s The African Queen (1951)

High Noon (1952)
Ben Hur (1959)

1960s Becket (1964)
2001: A Space Odyssey (1968)
Butch Cassidy and the Sundance 
Kid (1969)

1970s The Godfather (1972)
One Flew Over the Cuckoo's Nest 

(1975)
Star Wars (1977)

1980s Amadeus (1984)
Kiss of the Spider Woman (1985)
Platoon (1986)



1990s Dances With Wolves (1990)
The Silence of the Lambs (1991)

How do I avoid problems while playing a 
film clip?

One way to ensure the quality of a film clip is to 
close all of the dialog boxes (Find Word, Options, 
Topics Found) associated with Find Word before you
play a film clip. At present, conducting both of these 
tasks at the same time results in lower quality in the 
film clip.

 Once you start to play a film clip, you should NOT 
eject the disc from the CD-ROM drive until the film clip is
finished. Windows will hang if you do so.

Dealing with Sound Problems

How do I play the dialogue or music excerpt
after I've selected it?

To hear the selected dialogue excerpt or play 

music, click .

To pause in a dialogue or musical excerpt, click

.
(If you click a button on the Controller or 

elsewhere, you stop the excerpt.)

To see the text of the dialogue excerpt, click

. 

To control a film clip, click  to pause in it,

 to stop it, and  to play it.

 Be sure to single-click . If you double-click it, 
you start it, but then you immediately pause.

What can I do if I can't get sounds to play?
Here are some suggestions:

Check the volume on your sound card. Also, 
check the volume on the software controls ('mixer' or 
'volume control') used to run your audio card.



If the volume is turned up and you still hear no 
sounds, something may be wrong with your sound board
installation. Check to see that the sound board software 
is installed correctly and if it isn't, reinstall it.

If the software is installed correctly, the sound 
board may need to be pressed more securely into its 
slot or you may need to change a jumper setting.

If you have both a sound board and special 
software that bypasses the sound board to play sounds 
through the PC speaker, you could remove or disable 
the special software (the PC speaker driver). Cinemania 
'94 requires a MultiMedia Personal Computer (MPC) 
compatible sound board and it is not meant to run with 
just the PC integral speaker or any combination of that 
speaker and special software.

What can I do if I get an "Audio failed" error
message?

Make sure that the MCI Sound driver is loaded. 
Click the Control Panel icon in the Program 
Manager Main group window, click the Drivers icon, 
and verify that [MCI] Sound is one of the drivers 
installed. 
If the [MCI] Sound driver is not installed, click Add, 
and select the driver from the list. You will then be 
prompted to insert one of your original Windows 
diskettes.
If the [MCI] Sound driver is installed, check to see if 
it is functioning properly:
1.From the Accessories group window, click the 

Media Player icon.
2.Choose Sound from the Device menu.
3. In the Open dialog box, click one of the wave files 

(for example, chimes.wav), and then click OK.

4.Click the Play button  and see if the sound 
plays.

How can I improve the quality of the 
sounds I play in Cinemania '94?

Sound distortion
Volume controls: Try turning the volume control 
down on your sound board. (Check the 
documentation that came with your sound board to 
find out how to do this.) Generally, there is either a 
volume dial on the back of the board (at the rear of 
the computer where the speakers plug in) or you 
use a program often called a "mixer," which you can 
find in the Windows Control Panel of the Main 
program group. Some sound boards require that you



adjust both controls.
Media Vision Pro Audio Spectrum 16 driver: If you 
are using this audio driver on a 486 EISA computer, 
you may experience sound distortion. See your 
Media Vision documentation for instructions on 
changing your DMA setting to 7.

Sound skipping
You may experience audio breaks or skips if your 
CD-ROM drive does not fully meet the Multimedia 
Personal Computer (MPC) specifications for Data 
Transfer rate. The CD-ROM drive should transfer 
data at a rate of 150 KB per second while utilizing 
40% or less of the CPU. Contact your CD-ROM 
manufacturer for information on MPC compatible 
drives.
Sound interruptions
If you are running another sound producing program
at the same time you're running Cinemania '94, you 
may have problems with one interrupting the other. 
Try running only one sound producing program at a 
time.

Dealing with Display Problems

Why is Cinemania '94 displayed in gray 
instead of color?

The Setup program analyzes your system while it is 
setting up Cinemania '94. If it discovers that your 
system is using less than the 256-color video display
for which Cinemania '94 was designed, it adjusts 
your video mode. Cinemania '94 is then displayed in
sixteen shades of gray so that the photographs will 
look their best.

What if I have problems with the 
appearance of Cinemania '94?

In some situations, Cinemania '94 may encounter 
video display problems when using accelerated 
video drivers, video drivers with a lot of colors, or 
high resolution video drivers. When using one of 
these drivers, be sure it is the latest one available 
for Windows from your video card manufacturer. 
Contact your hardware or video card manufacturer 
for information on obtaining updated drivers for 
Windows 3.1. 

How can I find out what kind of display driver is 
installed?

1.In the Windows Program Manager Main window, 
click the Windows Setup icon.

2.From the Options menu, choose Change System 



Settings.
The type of display driver currently installed 
appears in the text box.

If you have problems displaying pictures or Demos 
while running Cinemania '94, try installing a 
standard video driver such as VGA. 
Warning: You must select a video driver that is 
compatible with your specific video card. If you 
install a driver that cannot work with your card, 
Windows may not start or run correctly. If this 
happens, go the DOS prompt, change to the 
Windows directory, if necessary, type setup, and 
change your display driver to the one you were 
using previously. 

To change your video driver:
1.In the Windows Program Manager Main window, 

click the Windows Setup icon, click the Control-
menu box in the upper-left corner, and then click 
Open.

2.From the Options menu, choose Change System 
Settings.

3.From the Display option, select a video driver from
the list of available drivers, or, if you have a new 
unlisted or updated driver, install it. 

For more information on using Windows setup and 
changing display drivers, see your Windows User's 
Guide.

If you have tried the standard VGA driver and 
continue to have display problems in Cinemania '94,
try running Windows in Standard Mode.

To run Windows in Standard Mode:
1.Close Windows.
2.At the DOS prompt, type win/s

Windows will start in Standard Mode.
3.Start Cinemania '94 and see if you still have a 

problem with the display.
If you display is all right, try starting Windows in 
Enhanced Mode.
To run Windows in Enhanced mode:
1.Close Cinemania '94, and then close Windows.
2.At the DOS prompt, type win/d:xv
3.Start Cinemania '94 and see if the display is 

acceptable.

If this has solved your problem, you now need to
modify your SYSTEM.INI file:
1.Close Cinemania '94.
2.Open a word processing or text editing program.
3.Open the SYSTEM.INI file (it is in your Windows 



directory.)
4.Find the [386Enh] section.
5.Type the following two lines anywhere in that 

section:
EMMEXCLUDE=A000-EFFF
VIRTUALHDIRQ=OFF

6.Save the file, close Windows, and reboot your 
computer.

 If you no longer have display problems, you may 
have an upper memory block conflict or a conflict with a 
Windows virtual device driver. You may have to use your
memory manager to exclude areas of memory in use by 
your video card or other drivers. Consults your DOS 
User's Guide, or your Windows User's Guide for more 
information.
If you still have display problems, remove all 
unnecessary programs in Windows, such as screen 
savers and third-party Windows shells. Also remove any 
memory resident programs from DOS, such as screen 
savers, anti-virus software, file-protection software, 
shells, and other TSRs.
If your problem is not solved, contact your computer 
dealer.

If your display driver is not VGA:
1.In the Windows Program Manager Main window, 

click the Control Panel icon.
2.Click the Windows Setup icon.
3.From the Options menu, choose Change System 

Settings.
4.Change the Display setting to VGA 
5.Click OK.
6.Close Windows and reboot your computer.
7.Open Cinemania '94 and see if the display is 

acceptable.
8. If the problem still exists, follow the procedures 

described above for a VGA driver.
If the problem is solved, your current video driver is 
probably having problems rendering the images in 
Cinemania '94. You might want to consider choosing
another video driver (if available) provided by your 
video card manufacturer.]

Improving Performance

How can I improve the performance of 
Cinemania '94?

Cinemania uses a lot of your system memory to 
display graphics and film clips. If you find that 



Cinemania runs slowly, consider doing the following 
to improve your computer's performance:

Close all programs in Windows and in DOS that 
aren't necessary for Cinemania '94. This includes screen
savers, shells, and TSRs.

If your computer is a 386 or higher set up a 
permanent Windows swap file on an uncompressed 
hard drive. Windows usually creates a temporary swap 
file, but if your hard disk is full or fragmented, this 
temporary file can become unavailable.    Make the size 
of the permanent swap file at least 2048K. See your 
Windows User's Guide for more information. 

If you have a 386 or higher with only 2MB of 
RAM memory and you encounter out-of-memory errors, 
or if sound is not continuous and the Demos are slow, 
make sure you're running Windows in 386 Enhanced 
Mode.

To find out what mode of Windows you are in:

From the Help menu in the Program Manager 
window, choose About Program Manager.

Here you can see what mode Windows is running 
in, how much free memory is available, and 
what percentage of your system resources is 
free. 

To run Windows in 386 Enhanced Mode:
1.Exit Windows.
2.At the DOS prompt, type win/3

If your computer runs at 20 MHz or slower, and 
you have only 2 MB of RAM, use a 16-color driver for 
your display, even if you have a 256-color card. 

To change your video driver:
1.From the Program Manager Main group window,

click the Windows Setup icon, and then choose 
Run from the File menu.

2.From the Options menu, choose Change 
System Settings.

3.Change the Display to standard VGA or another 
compatible 16-color video card driver. 
For more information on installing video drivers, 
consult your Windows User's Guide.

Run Cinemania without the SmartDrive device 
driver.    

To disable SmartDrive, do one of the following:
1.Open the CONFIG.SYS file in Notepad.
2.Change the DEVICE=SMARTDRV.SYS line to



REM DEVICE=SMARTDRV.SYS
3.Save the CONFIG.SYS file and then reboot your

computer.
-or
1.Open the AUTOEXEC.BAT in Notepad.
2.  Change the line
SMARTDRV.EXE

to
REM SMARTDRV

3.Save the AUTOEXEC.BAT file and then reboot 
your computer.

Defragment ("clean up") your hard disk by 
running a disk defragmentation program. For example, 
MS-DOS 6.0 includes a utility called Microsoft Defrag. 
(Be sure to run the utility in MS-DOS, not in Windows.)

Make sure that your CD-ROM drive is MPC-
compatible (the drive should be able to transfer data 
from the CD at 150 KB per second while using less than 
40% of the CPU bandwidth AND the drive should have 
an average seek time of less than one second. Check 
the documentation that came with your CD-ROM drive 
to see if it meets these standards.

Add more extended memory to your computer. 
You can determine how much extended memory is 
available by typing MEM and pressing Enter at the DOS
prompt.    You need a minimum of two megabytes (MB) 
of memory to play sounds and film clips, and run 
Demos.

For comprehensive documentation on improving 
performance, consult your Windows manual.

Ejecting the CD-ROM Disc

What happens if I remove the CD-ROM disc 
while running Cinemania '94?

Generally, it is not a good ideal to remove the disc 
from the CD-ROM drive while Cinemania '94 is 
running. 
If you eject the disc while Cinemania '94 is running, 
and then click hot text (say, a movie title in a review),
you get a system error message: "Cannot read from 
drive D:"
Reinsert the Cinemania '94 disc, and then click 
Retry. You may have to click Retry several times 
before the disc is recognized. If you are still unable 
to return to Cinemania '94, click Cancel, and close 
Cinemania '94.





{ewl MvBmp2, ViewerBmp2, !error.shg}

A-B A list by that name already exists. 
A subexpression within parentheses begins or ends 
with an operator.
A word is expected after the operator.
A word is expected before the operator.
All wave devices that can play files in the current format are in 
use. Wait until a .wav device is free and then try again.
An error occurred while attempting to load the movie.
An error occurred while attempting to play the movie.
An error occurred while attempting to stop the movie.

C Cannot create annotation because the annotation file is read-
only. Check target disc to make sure it has sufficient space and 
is not read-only.
Cannot find printer or printer driver. Check path to .DRV file and 
check printer.
Cannot find Viewer file. Make sure the correct disk and directory
are specified.
Cannot print to specified printer; run the Windows Control Panel
application to install and set up printers.
Cannot read or write to this disk; make sure the correct disk is in
the drive.
Couldn't open MCI device.
Couldn't open multimedia controller window.
Couldn't open multimedia element window.
Couldn't open multimedia window.
Could not print: "<listname>".

D-L Delete "<moviename>"?
Error occurred attempting to open the specified multimedia 
device.
Filename extension of the specified multimedia file is not 
associated with any installed MCI devices.

M-S Movie could not be deleted.
Multimedia controller failed due to an out-of-memory error.
Multimedia controller requires Windows with multimedia.
No list is selected.
No printer is installed, or the selected printer is set to None.
No printers are installed; use the Windows Control Panel to 
install printers.



Not enough memory. Close one or more applications or features
and try again.
Out of memory. Try closing other applications.
Permanently remove deleted lists?
Save changes to "<listname>"?

The The annotations file is damaged; delete the .ANN file and create
annotations again.
The list is empty.
The query contains a word with an improper wildcard. Search 
words cannot begin with a wildcard (*), and the wildcard must 
be the last character in the word.
The query failed because of disk-seek error occured.
The query failed because of a disk-read error.
The query failed because of an out-of-memory error.
The query failed because Viewer could not create a required 
file.
The query failed. Viewer could not open a required file because 
too many files are open.
The query has too many terms.
The query is empty or has no searchable words. You cannot 
search for words marked as stop words (for example, "the," 
"that," or "a").
The query is missing a parenthesis mark.
The query is missing a quotation mark.
The query is too complex. Do not nest parentheses more than 
five levels deep.
The query is too long or too complex. Select fewer options or 
select All Topics instead of Last Topics Found, and then try the 
request again.
The Viewer application has been damaged; delete 
MVIEWER2.EXE and run the title setup to install Viewer again.

There-Z There are no lists to delete.
There is no disc in the drive, or your Cinemania '94 files are 
corrupt; please insert the Cinemania '94 CD-ROM disc, or run 
Setup again.
There is not enough memory to print: close one or more 
applications and try again.
There is not enough space on the disk; delete one or more files 
and try again.
There is not enough space on the disk to create a temporary 
print file; delete one or more files and try again.
There is not enough space on the disc to save annotations. 
Delete one or more files from the disc, and then save.



This drive does not exist or is not connected. Choose another 
drive.
This file is not a Viewer title file and cannot be opened in this 
application.
Too many matches. Type a word or phrase that is more specific.
Unable to run the specified file.

 You have used a subexpression within parentheses that either 
begins or ends with an operator (AND, OR, NOT, NEAR), which 
is not allowed. Or, you typed a word that is too common to 
search for. Type the Find Word request again, including specific 
words and making sure that any subexpression within 
parentheses does not begin or end with an operator.

 A Find Word request cannot end with an operator 
(AND, OR, NOT, or NEAR). You did not type a word after 
the operator or you typed a word after the operator 
that is too common to search for (such as the). Try 
typing a specific word after the operator.

 A Find Word request cannot begin with an operator (AND, OR,
NOT, or NEAR). You did not type a word before the operator or
you typed a word before the operator that is too common to 
search for (such as the). Try typing a specific word before the 
operator.

 Cinemania '94 cannot play the selected dialogue or music 
excerpt, because too many wave devices (devices that play 
sound or music) are in use. Shut down one or more devices, 
and then try again.



 You are trying to play (start, play, or stop) the Demo, but there 
is not enough memory available, or there is a problem with 
Windows. If you are using other multimedia elements, close 
them to free memory, then try again. If you still cannot play the 
Demo, close one or more applications or features and try again. 
If the problem continues, try closing and then restarting 
Windows. If you still have problems with the Demo, check your 
installation of Windows or reinstall Cinemania '94.

 Cinemania '94 cannot create the annotation file. Check the 
Cinemania '94 disc or your hard drive to make sure space is 
available. If there is not enough disk space, delete one or more
files to free disk space, then try again. If space is available, 
make sure that the CNMNIA94.ANN file does not have the 
read-only attribute. If the file has the read-only attribute, 
double-click the File Manager in the Windows Main group 
window. Click CNMNIA94.ANN. From the File menu, choose 
Properties. In the Properties box, uncheck the Read Only 
Attribute. Then click OK.

 Windows cannot find the .DRV file for the printer you've specified,
or the printer is not responding to your computer's signal. Make 
sure the printer is turned on, connected to the computer, and is 
ready to print. Make sure you have not moved or deleted 
any .DRV files. Double-click the Control Panel icon (usually in the 
Program Manager Main group window). Double-click the Printers 
icon to see the Printer dialog box, and then reinstall printer files if 
necessary.

 You are trying to open Cinemania '94 by double-clicking its 
icon in Program Manager, but the program cannot be found. 
First make sure the Cinemania '94 compact disc is in the disc 
drive. Then use the Properties command on the Program 
Manager File menu to make sure the specified path is to the 
compact disc drive. If you still cannot open Cinemania `94, the 
VIEWER.INI file may be damaged. This file stores the location 



of the Cinemania '94 files. Use File Manager to start the Viewer
program (the executable file is MVIEWER2.EXE), then open 
the program by using the Open command on Viewer's File 
menu. Opening the program from within Viewer will fix the 
VIEWER.INI file.

 Windows cannot find the .DRV file for the printer you 
specified. In the Program Manager main window, double-click 
the Control Panel icon, then double-click the Printers icon and 
correct the printer settings.

 The Viewer program cannot use the disc in the drive. Make 
sure the disc in the drive is the correct disc.

 You are trying to play the Demo, a dialogue excerpt, a music 
excerpt, or a film clip, but there is a problem with the respective 
driver in your Windows installation. In the Program Manager 
Main window, double-click the Control Panel icon, double-click 
the Drivers icon, and then check the driver settings to make sure
the device is correctly installed. Try closing and then restarting 
Windows. If you still have problems with the feature, check your 
installation of Windows, or reinstall Cinemania '94.

 The printer is not responding to your computer's signal. Make sure 
the printer is turned on, connected to the computer, and is ready to 
print.



 Cinemania '94 is prompting you to confirm the deletion of the 
selected movie.

 You are trying to play a dialogue excerpt, music excerpt, or 
film clip that is not compatible with any of the installed MCI 
devices. The appropriate files are identified by the filename 
extension (.wav for a dialogue or music excerpt and .api for a 
film clip).

Choose another dialogue excerpt, music excerpt, or film clip.

 The movie you are trying to delete from a list has not been 
deleted. Try again.

 You are trying to play the Demo, a dialogue excerpt, a music 
excerpt, or a film clip when there is not enough memory 
available, or there is a problem with Windows. If you are using 
other multimedia elements, close them to free memory, or close
one or more applications, and then try again. If you still cannot 
play the feature, close and restart Windows. If you still have 
problems, check your installation of Windows. To use all the 
features in Cinemania '94, you need at least 2 megabytes of 
available memory.

 You are trying to play the Demo, a dialogue excerpt, a music 
excerpt, or a film clip, but Windows is not installed properly. 
Check your installation of Windows.



 You pressed "Add Movie" but no list is selected. Select the 
list to which you want to add the movie.

 Cinemania '94 is not able to print. In Cinemania '94, choose Print
Setup from the File menu. Check the settings to see that the 
correct printer name is displayed and that the printer is set to the 
active port (usually an LPT port). If no printer name is displayed, 
click Cancel to close the Print Setup box, minimize Cinemania 
'94, and double-click the Control Panel icon in the Windows 
Program Manager Main group window. Double-click the Printers 
icon, and then install the correct printer.

 Windows cannot print because no active printer has been 
identified. In the Windows Program Manager Main group 
window, double-click the Control Panel icon, and then double-
click the Printers icon and install your printer.

 You are trying to use Find Word but there is not enough 
memory available. Close one or more applications or features 
to free memory, then try again. To use all of the features in 
Cinemania '94, you need at least 2 megabytes of available 
memory.

 You are trying to open a file when there is not enough memory 
available. Close one or more applications or features to free 
memory, then try again. To use all of the features in Cinemania 
'94, you need at least 2 megabytes of available memory.



 Cinemania '94 is prompting you to confirm the deletion of the 
selected list.

 Cinemania '94 is prompting you to confirm the changes you 
have made to the list before saving it.

 The Viewer program cannot open the annotations file 
because the file is damaged in some way. Delete the 
CNMNIA94.ANN file from the Cinemania '94 directory, and 
then use the Annotate command on the Edit menu to create 
annotations again. Deleting the CNMNIA94.ANN file deletes 
all annotations. The Viewer program will automatically create a
new CNMNIA94.ANN file when you create new annotations.

 You have used the asterisk wildcard character (*) incorrectly in 
your Find Word request. The asterisk may be used only at the 
end of a word.

 You clicked "Delete Movie," "Print List," or "Delete List" but 
the selected list is empty.

 The Multimedia Viewer program cannot use the disc in the 
drive. Make sure the Cinemania '94 disc is in the CD-ROM 
drive.



 The Find Word feature cannot complete the request because 
of a disc error. Check the disc for errors.

 You are trying to use the Find Word feature to do a full-text 
search in Cinemania '94 when there is not enough memory 
available. If you are using other multimedia elements, close 
them to free memory, then try again. If you still cannot use this 
feature, close one or more applications and try again. To use all 
of the features in Cinemania '94, you need at least 2 megabytes
of available memory.

 Cinemania '94 cannot carry out your Find Word request. 
Check the Cinemania '94 disc or your hard drive to make sure 
space is available. If there is not enough hard disk space, 
delete one or more files to free disk space, and then try again.

 The Find Word request failed because you have too many files
open. Close one or more applications or features, then try 
again.

 Your Find Word request is too complex. Type fewer words or 
operators in the text box, and then try again.

 You either misspelled a word in your Find Word request or 
typed a word too common to look for (such as the). Type a new



query in the text box, including the specific words you want to 
find.

 Your Find Word request is missing either an opening or a 
closing quotation mark. Add the quotation mark and try again.

 Your Find Word Request is missing either an opening or a 
closing parenthesis mark. Add the parenthesis mark and try 
again.

 Your Find Word request contains parentheses nested more 
than five levels deep. This is not allowed in Cinemania '94. 
Revise your Find Word request and try again.

 You have misspelled a word in your Find Word request or 
typed a word that is too common to search for (such as the). 
For instance, if you search for the word the, you would get 
this error message. Correct the spelling or use more specific 
words.

 You clicked Delete List but no list is selected. Select the list to 
be deleted.



 You are trying to start Cinemania '94, but Cinemania '94 is 
having a problem finding the files. Either there is no CD-ROM 
disc in the drive, or your Cinemania '94 files are corrupt. Make 
sure that the Cinemania '94 CD-ROM disc is in the drive, and 
try again. If you still have a problem, run Setup again.

 You are trying to print when there is not enough memory 
available to hold the temporary print file. Close one or more 
applications to free memory, then try again. To use all of the 
features in Cinemania '94, you need at least 2 megabytes of 
available memory.

 Your hard disk does not have enough space to save the file. 
Delete one or more files from the disk to create disk space, then
try again.

 You are trying to print when there is not enough space available 
on the hard disk to hold the temporary print file. Delete one or 
more files from the hard disk to create disk space, then try again.

 There is not enough space on the target disk to save 
annotations in the CNMNIA94.ANN file. Delete one or more 
files from the hard disk to make more space, then try again.

 The Viewer program is damaged. Using File Manager or DOS, 
delete MVIEWER2.EXE, then run the Cinemania '94 Setup 
program again to reinstall Viewer from the original disc.



 You have typed a drive letter that does not exist or is not 
connected. Type the drive letter of an existing drive.

 You are trying to open a file that is not a Viewer file. The Viewer 
program can open only those files that have .MVB (book) or .HLP 
(help) extensions.

 You have typed a word that is too common to search for 
(such as the). Type a more specific word or phrase, then try 
again.

 You are trying to open a file that is not an executable file or is 
not compatible with the other software you are using.

 You typed a title for your new list that already exists. Type 
another title in the box. If you want to display one of the 
existing lists, click its title.

 The files containing your lists are saved in a directory on 
your hard disk. You CANNOT edit these lists, but you can back 
up the files, if you wish, or change the location of the directory. 
The Viewer.ini file in your Windows directory contains a section 
called [CNMNIA94].
In that section you'll find the following statement:
LISTPATH=[directoryname]




